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1. Introduction 
AquaSim is an analysis tool developed by Aquastructures AS. It uses the Finite Element Method (FEM) 

for calculation and simulation of structural response. The software is well suited for slender, lightweight- 

and large volume structures, flexible configurations and coupled systems exposed to environmental 

loads such as: 

- waves 

- currents 

- wind 

- impulse loads 

- operational conditions 

- resonance 

This manual describes the functionality of the post processing tool AquaEdit. 

1.1 The AquaSim software package 
The AquaSim package consists of several programs, as well as the AquaSim solver. Also included is 

several postprocessing tools.  

1.1.1 AquaEdit 
Building geometrical models through a graphical interface. Structural and hydrodynamic properties are 

defined and added to the graphical model.  

1.1.2 AquaSim solver 
Having prepared the input by an analysis model, one starts the AquaSim solver to derive results. This is 

the part that calculates the results from the given input of geometry, properties, loads and environment. 

AquaSim handles global analysis and interactions of forces transmitted between stiff and flexible 

components. AquaSim establishes simultaneously a visual simulation of displacements, accelerations, 

and deformations in the structure AquaSim calculates for each step the local section forces, stresses, 

and stress ranges in each system component, applicable to local analysis and fatigue assessments. 

AquaSim is based on real-time simulations. This implies that AquaSim considers the nonlinear effects, 

such as geometrical changes in the component’s cross-section, to continuously maintain the correct 

relation between e.g. the applied forces and the resulting displacements.  

AquaSim considers hydroelasticity, handling the interactions and coupled dynamics between the 

external loads and the construction. Deformations and changes in the global structural geometry will 

imply changes in the load scenario applied to the construction. 

For more technical information about the AquaSim solver read the report in (Berstad A. J., The AquaSim 

package Theory user manual, 2021). 

1.1.3 AquaView 
The 3D results viewer, AquaView presents results from the solver graphically. For more information read 

the AquaView manual (Aquastructures AS, 2022f). 
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1.1.4 AquaTool 
AquaTool presents the results from the AquaSim analysis in tables and diagrams. For more information 

read the AquaTool manual (Aquastructures AS, 2022e). 

1.1.5 Post-processing tools 
There are several post-processing tools included. These are covered in an own user manual which is 

available on request from the user (Aquastructures AS, 2022g). 

1.2 Terminology 
These terms appear throughout this document: 

 Definition 
Node Point in 3D space that describes end points of element.  
Element Object between two nodes (straight element) or four nodes (membrane element). 

The simulation process will treat each element as a discrete object, so for higher 
resolution results, add more elements. 

Beam A beam is a structural element that is capable of withstanding load primarily by 
resisting torsion and axial loads.  

Membrane Structural element used for nets 
Truss Structural element where forces in the members are either tensile or compressive 

forces. I.e. Ropes. 
Node2node Spring element going from one node to another. 
Component  A group of elements which is defined by the same material data. Components are 

defined either as beam, truss, membrane or node2node. 
Shape Shapes are predefined 3D models that can be imported and viewed as part of the 

main model but does not affect the simulation in any way. 
Terrain Terrain data can be imported from several sources. Point data type terrain data 

should be used. The terrain will be imported and optimized for viewing and usage. 
Decorator An attribute added to a node or an element, like pointloads, hinges, etc. 
Intent A function used in the main view; draw line, extrude, split line etc. 

 

 

  



   

9 
AquaSim 2.17 

2. Interface 
2.1 Main view 

 

Figure 1 - The main application view 

A picture of the main view is shown in Figure 1. More detailed description of the view is described in the 

following chapters. 

2.2 Interacting with the 3D model 
Name Function 
Select Press left mouse button or hold down left mouse button for box select. 

Press ctrl and left mouse button to select more, or to de-select selected 
node/element. 
Hold ctrl and left mouse button add several nodes/elements to the selection. 
Hold shift to select only nodes when box selecting. 

Rotate Press and hold down middle mouse button. 
Pan Press and hold down right mouse button. 
Zoom Scroll with mouse wheel. Holding down CTRL at the same time as zooming will use 

the alternate zoom acceleration. See Settings: Drawing 
The keyboard can also be used for zooming. These shortcuts can be found under 
Commands > Zoom. 

Lock  Locks the location of Tool Windows to the Main View. 

Cursor in the 3D view The cursor changes related to the action selected by the user: 

Drawing intent is selected       

Translation and rotation of model       
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2.3 Toolbar 
The toolbar allows for toggling of several functions: 

Name Function 
Update Forces a redraw of the screen in case a command does not update correctly 
Grid Toggles visibility of grid 
Axis Toggles visibility of axis 
Membranes Toggles visibility of membrane elements 
Shapes Toggles the visibility of shapes 
Crosssection Toggles the visibility of cross-sections on beams 
Normals Toggles the visibility of normals (the projections of point3) 
Snap Toggles whether commands are forced to snap to closest node. Snap modifier 

determines how close something must be to enable snapping. This can be set by 
entering a new value into the box behind the snap modifier box. Pressing enter will 
set a new snapping threshold. 

Export Opens the environment data and export to AquaSim window. 
Copy model See chapter Copy model. 

 

Tip! Right click on the toolbar to unlock/ lock the functions. By unlocking, the user 

may drag-and-drop the Tool-windows to the docking area or place it in the 3D view. 

 

  



   

11 
AquaSim 2.17 

2.4 Intents 
Tool window for selecting the active intent. A more detailed description of the intents can be found in 

chapter 3. 

 

 

Tip! Right click in the blue area of the Tool-window for more options. 

 

2.5 Views 
The view window can be used to view the model from different perspectives. The shortcuts for these 

can be found under Commands > Views. 

 
Figure 3 - View window 

The default views are isometric, top-down, front and side. The second last button zooms to selected 

nodeselements.  

The last button toggles between perspective (default) and orthogonal view. 

2.6 File 
The file window with shortcuts to some basic options. Shortcuts for these can be found under File. 

Pointer 
 

Draw line 
 

Draw rectangle 
 

Draw 
membrane 
rectangle 

 
Draw circle 

 
Draw tube 

 

Move 
 

Rotate 
 

Scale 
 

Duplicate 
 

Extrude 
 

Mirror 
 

Split line 
 

Intersect 
 

Merge lines 
 

Measure 
distance  

Measure angle 
 

Select quad(s) 
 

Draw 
membrane  

Select node(s) 
 

Select 
element(s)  

Select 
component  

Box select 
 

Rotate view 
 

Figure 2 - Intent tool window 
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Figure 4 - File window 

The options here are; New, Open and Save. 

2.7 Object properties 
This window will change accordingly to what is currently selected in the main window, examples below. 

    

Figure 5 - Component selected on the left, node selected on the right 

     

Figure 6 - One element selected on the left, two elements selected on the right 

Figure 5 and Figure 6 shows what this window may look like depending on what is selected. A more 

detailed description is explained in chapter 4. 

2.8 Tool properties 
This window will contain properties regarding the current selected intent, the intents is shown in Figure 

2 and is discussed further in chapter 3. A couple examples is shown below. 
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Figure 7 - Properties for drawing circle on the left, properties for splitting on the right 

2.9 Decorators 
All the decorators added to the model will be listed in this window. A dropdown menu can be used to 

filter the list to only show the decorators the user is interested in. Each decorator has a popup window 

when the user right clicks on an item in the list. 

 

Figure 8 - Node decorators window with some decorators that are added to the model on the left, popup window on the right 

The checkbox in front of each decorator toggles visibility in the 3D view. 

By left clicking on the color behind a decorator will bring up a color palette where the color of the 

decorator can be altered. This color will be what the node(s) belonging to the decorator is drawn as. The 

default color is red. Note: This only works for decorators on nodes. 

The property window of the decorator can be activated by double clicking an item in the list or selecting 

“Edit” in the popup window. 

By selecting “Select nodes/elements” in the popup window the user can select all the nodes or elements 

that share the selected decorator. 

By selecting “Deactivate” in the popup window the user can exclude the decorator from an analysis. 

Selecting “Delete” removes the selected decorator from the model. 

2.10 History 
This window contains information of what the user has done while working on a model. An example can 

be seen in the picture below. 
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Figure 9 - History window 

2.11 Log viewer 
This window contains information on what the user has done while working. In contrary to the History 

window the Log viewer window is not reset when opening another model or creating a new model. It 

also contains some more information and when input is needed from the user the Log viewer will 

contain information about this. An example is shown below, where a rectangle has been drawn. 

 

Figure 10 - Log viewer after a rectangle has been drawn 

2.12 POIs 
Shows the Points Of Interest. E.g. the node names. 

 

 

 

 

 

Figure 11 - POIs window 
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2.13 DOFs 
Shows all DOFs in the current model. If a DOF is selected in the list, the corresponding node is selected 

and zoomed in. All DOFs can be edited directly in the list, and if a DOF is added/edited in the window for 

node properties then the DOF list will be automatically updated. 

 

 

2.14 Components 
The components window shows a list of all the components in the current model. By default, the 

window sorts the components based on their type (beam, membrane, membrane_x, truss, node2node, 

shape, in that order), see Figure 13. 

The checkbox in front of each component toggles the components visibility in 3D view. Components that 

are not visible cannot be interacted with. 

If a component is lacking properties, the name will be shown in cursive. It is possible to rearrange the 

component list by dragging and dropping one or several selected items.  

 

Figure 13 - The Components window on the left, popup window on the left 

Figure 13 shows an example of a components window. The popup window on the right is shown when a 

user clicks on the ˅-button on the top-right corner of the window.  

Figure 12 - DOFs window 
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Figure 14 - Right click 
on a component 

New components can be added by clicking the button “New component”, using the shortcut that can be 

found in Edit, or using the Library under Tools > Library. The user can drag and drop files from the 

Library window. If the user drags in one file over a component the user will get a question asking if the 

component should load this file into it, or if the user wants to create a new component based on the 

contents of the file. If the user drags in several files, the program will automatically create new 

components based on the content of these files. 

2.14.1  Color 
Left clicking on the color behind each component brings up a color palette where the color can be 

altered.  

2.14.2  Component options 
Right clicking on a component brings up a list of options for the selected component, see Figure 14. 

Set name 

Sets the name of the component, keyboard shortcut F2. Name of component can 

also be changed in the property window for the component by selecting Edit. 

Type 

Sets the type of component; beam, membrane, membrane_x, truss and 

node2node. If the component contains properties a warning will be shown before 

changing the type (which removes all pre-existing properties). 

Visibility 

Toggles the visibility, equal to using the check marks in front of the components. 

Using the “Show only this” option will turn the visibility of the component on, while 

turning visibility of the other components off. 

“Show stress” wil turn on/off stress coloring in AquaView when results are opened. 

Lock 

Disables any editing of the component. 

Deactivate 

Deactivates the component from analysis. 

Operations 

Select 

Select all elements of the component. 

To active component 

Will move all selected elements to this component. 

Copy from 

Will copy properties from a valid selected component. 

Merge 

If multiple components of the same type are selected, they will be merged into one. Only the properties 

of the first selected component will be used. 
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Add contact 

Adds a contact between two selected components.  

 

Figure 15 - Component contact 

Properties Description 
Distance Distance before center of node and center of element the contact 

starts. 
Stiffness Stiffness of contact. 
Damping stiffness Damping proportional to stiffness at contact, normal direction. 
Dynamic friction damping Dynamic friction damping proportional to stiffness parallel to 

element. 
Static stiffness friction coeff Static stiffness friction coefficient proportional to stiffness. 
Max initial distance Max initial distance where contact elements are introduced if larger 

than 0. 

Calculate membrane volume 

Will show the static volume of the membrane (only available on membrane components). 

Convert to terrain 

Will convert the component to terrain data, using the elements of the component as basis for the 

terrain (only available on membrane components). 

Convert to explicit 

Will turn a component with type membrane over to the type membrane_x (explicit membrane). 

Delete 

Deletes this component. 

Library 

Opens the library for exporting or applying a template to the component. This dialog is explained in 

more detail in chapter Library. 
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Edit 

Brings up the property window for the component, this is explained further in the coming chapters. 

Double-clicking on the component or pressing ENTER will also open the property window. 
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2.14.3  Beam 

Information 

The first panel of the property window, see Figure 17, specifies the name and the description of the 

beam, as well as whether the beam has Morison or hydrodynamic load model. For more information 

about Morison and hydrodynamic load models, see (Berstad A. J., The AquaSim package Theory user 

manual, 2021). 

Choosing one of the items in the dropdown list under “Data source” will auto-generate cross-section 

values for the beam. This function calculates cross-section values for: Tube, hollow rectangular, massive 

rectangular, I/H-beam and double tube. All auto-generated values will be locked, to edit fields manually 

choose “Custom” in the dropdown list after generating the cross-section. There is also a possibility to 

draw your own cross-section in a separate 2D drawing program that opens using the data source 

AquaCross. This is explained in detail in its own user manual (Aquastructures AS, 2022d). 

The visual cross-section can be transferred to the hydrodynamic cross-section by clicking the button 

“Copy to hydrodynamic”.  

The text area contains the points in the 2D cross-section. Each line represents one point, with the 

coordinate on the y-axis first and the coordinate on the z-axis second. For a cross-section that is 

symmetric around the z-axis, only half of the points are needed, enabling “Symmetrical” will copy the 

points on the right-hand side of the z-axis over to the left-hand side and create a symmetrical cross-

section.  

The cross-section can be visualized in the 3D-window with the cross-section applied along the beam 

elements local x-axis. AquaEdit follows the right-hand rule, see Figure 16. Direction a in the figure is the 

direction from node A to node B (local x-axis), direction a x b is the local z-axis (see chapter Point 3) and 

direction b is the local y-axis. This is important to remember when drawing a non-symmetrical cross-

section and when editing point3 of the element. 

The beam can have an asymmetric cross-section as well. This means 

that the cross-section at node A and node B is different and AquaEdit 

will interpolate between them to create an asymmetric cross-section. 

Figure 18 shows three beam elements with a square cross-section at 

node A and a straight-line cross-section at node B. The button “Scale” 

will take cross-section at node A and scale it and then apply it to node 

B. 

Figure 16 – Right-hand rule 
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Figure 17 – Information panel 

 

Figure 18 - Asymmetrical beam elements 
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Material/section properties 

 

Figure 19 - Material/section properties panel 

Properties Description 
E-modulus Young’s modulus. 
G-modulus Shear modulus. 
Area Cross sectional area. 
Iy Moment of area around local y-axis. 
Iz Moment of area around local z-axis. 
It Torsional stiffness. 
Volume Hydrodynamic: Maximum buoyancy per meter 

Morison: Amount of added mass. Also relates to the added mass 
of the component. 

Mass density Mass density of material. 
Weight in air Weight in air of element, per length. 
Weight in water 𝑊𝑒𝑖𝑔ℎ𝑡 𝑖𝑛 𝑤𝑎𝑡𝑒𝑟 = 𝑤𝑒𝑖𝑔ℎ𝑡 𝑖𝑛 𝑎𝑖𝑟 − 𝑏𝑢𝑦𝑜𝑎𝑛𝑐𝑦 𝑜𝑓 𝑒𝑙𝑒𝑚𝑒𝑛𝑡  (if 

element is in air, then input is weight in air). If “With slamming” is 
chosen under Time series (see chapter Time series) then Weight 
in water must have an input. 

Rayleigh damping (mass) Extra damping on acceleration on elements 
Rayleigh damping (stiffness) Extra damping on stiffness on elements. 
Mass radius Average radius the mass has with respect to local x-axis 
Pretension Inner tension in element (pre-strain). 

 

A more detailed description can be found in (Berstad A. J., The AquaSim package Theory user manual, 

2021).  
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Stress calculation 

 
Figure 20 - Stress calculation panel 

The arms for bending and torsion, and shear constants/shear area. This is used to calculate stresses in 

the beam dependent on forces and moments acting on it.  

A more detailed description of bending, torsion and shear is found in (Berstad A. J., The AquaSim 

package Theory user manual, 2021).  
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Element loads 

For Morison load model: 

 
Figure 21 - Element loads panel, for Morison load model 

Properties Description 
Drag coefficient Y/Z Drag coefficient for local y- and z-axis. 
Added mass coefficient Cay/Caz Added mass coefficient for local y- and z-axis. 
Diameter for drag Y (depth) This will together with element length define drag area for 

element in local y-axis. 
Diameter for drag Z (width) This will together with element length define drag area in 

local z-axis. 
Wave generated damping 
coefficient 

In case element is in wave zone, additional damping can be 
included. Horizontal motion, Vertical motion, and Rotation. 

Slamming shape Shape of object going thought the water line. Default circle, 
but rectangular volume with height based on the drag height. 

Wave amplitude reduction 0 means full wave, 1 means no wave, 0.5 means half 
amplitude. 

Current amplitude reduction 0 means full current, 1 means no current, 0.5 means half 
current. 

Longitudinal drag coefficient Drag coefficient in local x-direction. 
Wind load See description below. 
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Wind load 

Wind load is activated/de-activated by clicking the checkbox. There are two alternatives to choose from 

in the drop-down list, type 1 and type 2. 

Type 1: 

Wind is added in local Y and Z directions on beams with the drag areas defined by min/max Y and Z, and 

drag coefficients. 

It is only possible to add wind perpendicular to the beam. To add wind in the direction of the beam; use 

a “dummy beam” perpendicular for the “main beam”. 

AquaSim uses the wind speed at an altitude of 10 meters as input. As the wind is reduced towards the 

surface, it is necessary to use the position of the top and bottom of the wind-affected area to get the 

correct wind force acting on the element. AquaSim takes into consideration the z position of the 

elements when calculating the correct wind force. 

Max/Min Y height is the top and bottom of that area. For horizontal elements with a default horizontal 

local y-axis, this is the height of the element. 

As some elements during the analysis tends to roll, or for some other reason the default y- and z-axis is 

changed, there would be a wind-affected area perpendicular to the local x-axis. For wind-affected 

elements, rolling, the Min/Max Z height describes the width of this element measured from the neutral 

axis of the element. See Figure 22 for illustration. 

The wind fetch area is then calculated from the element length, the differential in Max Z height and Min 

Z height along the elements local y-axis and the differential in Max Y height and Min Y height along the 

elements local z-axis. 
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Figure 22 - Wind load on an element 

Type 2: 

For type 2, wind forces are treated in the same way as drag loads from current. Force calculated is based 

on “Diameter for drag” and “Drag coefficient” under the tab “Drag Loads”. Instead of using current-

speed and density of water, wind-speed and density of air is used. Type 2 takes into consideration the Z 

position of the element. The wind profile is calculated according NORSOK N003, more information about 

this is found in (Berstad A. J., The AquaSim package Theory user manual, 2021). 

  



   

26 
AquaSim 2.17 

For Hydrodynamic load model: 

 

Figure 23 - Element loads panel, for Hydrodynamic load model 

Properties Description 
Hydrodynamic length coeff. Length of flotation on element (e.g. pontoons) divided by total 

length of element. Between 0 and 1. 
Neutral axis Z Vertical space between element and the elements cross-sectional 

centre. 
Waterline Z For adjusting the waterline level on the hydrodynamic profile. 

Positive level means more buoyancy. In addition, a blue line on the 
cross-section view indicates where the adjusted waterline is. 

Mass centre Z Vertical space between element and mass centre of the cross-
section. 

Viscous roll damping coeff. Damping coefficient for roll motion on beam. 
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Wave amplitude reduction Reduction of wave amplitude on element, due to e.g. shadow 
effects. A number between 0.0 and 1.0. 0 correspond to 0% 
reduction, 1.0 correspond to 100% reduction.  

Current reduction Reduction of current due to e.g. shadow effects. A number 
between 0.0 and 1.0. 0 correspond to 0% reduction, 1.0 
correspond to 100% reduction. 

Longitudinal drag coefficient Drag coefficient in local x-axis. 
 

A more detailed description of hydrodynamic loads can be found in (Berstad A. J., The AquaSim package 

Theory user manual, 2021). 

The Scale button with create an asymmetric cross-section where the cross-section on the B side will be 

the A cross-section scaled by this factor. 

The Move button translates the cross-section in the z and y dimension. Note that for mirrored cross-

sections it will only move the mirrored half. The correct inputs to the move dialog are z displacement, y 

displacement. 

Advanced 

For Morison load model: 

 

Figure 24 - Advanced panel, for Morison load model 
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Non linear data can be added to the beam. For more information about non linear data, see chapter 

Node2Node spring. 

Weight factor slamming can be activated if element is filled with water when submerged when using the 

“With slamming” under the Advanced tab in the Export dialog. This factor is the size of the non-filled 

volume (typical equal to area) divided by total volume (typical volume). 

Lift 

Properties Description 
Input type This indicates if data is given in radians or degrees 
Direction of lift Positive direction of element (corresponding to 0 degrees angle of incident 

flow) is along the local z-axis.  
1: The lift direction is in accordance with a normed space. 
-1: The inverse. 
-2: The rotation direction is opposite, but not the defined lift direction. 
-3: The lift direction is defined opposite, but not the angle. 

Diameter The coordinate length the drag and lift coefficients are multiplied with. They 
are also multiplied with the length of the element. 

Angle Angle between the in-flow and the local z-axis of the beam. If angle is 0, the 
local z-axis defines the 0-angle flow direction to the beam in the cross-flow 
plane. It is recommended to use angle 0 and direct the local z-axis to be in 
accordance with this. This is to avoid any miss on positive/negative angle. 

 

To define the lift for different angles it is necessary to add a table defining the different drag, lift and 

yaw coefficient for the incoming angle. Add rows by pressing ENTER inside the table. 

 

Properties Description 
Id Data number. 
Angle In-flow angle in the cross-flow plane relative to the local z-axis. 
Cd Drag coefficient in the flow direction. 
Lift coefficient Lift coefficient. Factor for force 90 degrees to the flow direction in the cross-

flow plane. 
Yaw coefficient Coefficient for rotation around the beam of the lift object. 
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For Hydrodynamic load model: 

 

Figure 25 - Advanced panel, for Hydrodynamic load model 

Properties Description 
Non linear data See chapter Node2Node spring. 
Horizontal component of hydrodynamic forces 
only 

Only horizontal components of the hydrostatic 
and hydrodynamic forces are accounted for. I.e. 
drift and drag forces. Meaning that the 
hydrostatic forces and vertical hydrodynamic 
forces are set to 0. 

Drift Toggle on to include calculation of wave drift 
forces. Wave drift forces are calculated by the 
default AquaSim methodology. 
 
Amount of drift applied: wave drift forces are 
reduced manually by reducing the amplitude of 
the incident wave. 1% corresponds to 1% of the 
incident wave, 50% corresponds to 50% of the 
incident wave, and so on. 
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2.14.4  Membrane 

Information 

 

Figure 26 - Information panel 

The first panel of the property window, see Figure 26, specifies the name and the description of the 

membrane. The type of membrane and load formulation can also be edited here. There are 3 

membrane types: Normal, Normal with bending stiffness and Shell. Based on what is chosen, the tab 

“Material properties” will show the input needed for said type. If type “Normal with bending stiffness” is 

chosen, then a tab named “Bending stiffness” will appear with the input needed. 

There are 6 Load formulations that can be used: Normal, General impermeable net, Morison free plate, 

Lice skirt, Closed compartment and Surface Tarpaulin. Based on which Load formulation is chosen, the 

tab “Material properties” will show the input needed for the Load formulation in question. For 

membrane type Shell, the Load formulations General impermeable net and Morison free plate is 

available. 
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Material properties 

 

Figure 27 - Material properties, normal 

Figure 27 shows the input for types Normal and Normal with bending stiffness.  

Properties Description 
E-module Young’s modulus. 
Thread diameter Diameter of the thread. 
Area Cross-sectional area of the thread. 
Mass density Mass density for the thread. 
Relative density in water Relative weight in water. Density of material subtracted density of 

salt water (1025 kg/m3 
No compression forces Forces in the net twines will be 0 if compressed. 
Pretension Y Elongation divided by length for threads in local z-direction. 
Pretension Z Elongation divided by length for threads in local y-direction. 
Growth coefficient Parameter to account for increased diameter of twines from fouling. 
Maskwidth Y The distance between the threads in horizontal direction. 
Maskwidth Z The distance between the threads in vertical direction. 
Solidity The solidity of the net. 
Solidity incl growth The solidity of the net, included fouling. 
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Volume Tick the Volume checkbox to perform volume calculations in 
AquaView. Choose if the net is open or closed in the upper or lower 
part. 

Rayleigh damping stiffness See Material/section properties for beam. 
Rayleigh damping mass See Material/section properties for beam 

 

 

Figure 28 - Material properties, Shell 

Figure 28 shows the input for type Shell. 

Properties Description 
Thickness Thickness of the plate 
Poisson Poisson modulus 
Added thickness coefficient Coefficient to increase/decrease thickness, used for finding volume 

for the Froude Kriloff part of force in Morison. 
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Load properties 

 

Figure 29 - Load properties, Normal and Normal with bending stiffness 

Figure 29 shows the input for types Normal and Normal with bending stiffness. 

Properties Description 
Mask type 1 is square mask, 2 is diamond mask 
Load type M1: Drag force is calculated depending on the element’s rotation 

relative to the current direction.  
M2: Same as M1, but drag coefficient is calculated based on the 
Reynolds number. 

Net in air Instead of drag from waves and current, drag will be calculated 
based on wind speed and density of air. 

Wave amplitude reduction Between 0 and 1, 0 is full wave and 1 is no wave. E.g. 0.5 means half 
wave amplitude. 

Current reduction Between 0 and 1, 0 is full current and 1 is no current. E.g. 0.5 means 
half current. 

Extra drag normal direction 
threads 

Factor that adds drag load on threads that are located “on the 
wheel” in normal direction. 

Extra drag tangential 
direction 

Factor that adds drag load on threads that are located “on the 
wheel” in tangential direction. 
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Figure 30 - Load properties, General impermeable net 

Properties Description 
Drag coefficient Gives the form drag to the cylinder with respect to 

the diameter of the cylindrically shaped net. 
Lift coefficient, peak value Gives the peak value for the pressure distribution. 
Density of fluid inside tank If the bottom factor is 0.0 (e.g., lice skirt), this 

parameter is a dummy. In this case the internal 
static pressure is set equal to the external pressure. 
If the bottom factor is 1.0, then this parameter is the 
density of the fluid inside the tank. The external 
pressure is calculated based on the density of salt 
water, 1025 kg/m3 

Height of fluid level inside tank relative to 
sea level 

This parameter is a dummy if the bottom factor is 
0.0. 
If the bottom factor is 1.0 then this value is the static 
water level of the fluid inside the tank, relative to 
the outside water level. Positive value means that 
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the inside water level is higher than the outside 
water level. 
This * area top gives the extra volume. 

Added mass coefficient Added mass coefficient horizontal motion with 
respect to 2D volume with the diameter at the given 
depth. 

Hydrodynamic damping coefficient Added mass coefficient vertical motion with respect 
to 2D volume with the diameter at the given depth. 

Bottom factor, 0 if water flow through 
bottom 

1.0 means that the inner volume is separated from 
the outer volume. 0.0 means that the inside and the 
outside fluids are connected, which is the case for 
lice skirts. 

Area top that water can penetrate over This parameter is a dummy if the bottom factor is 
0.0. 
When a net, where the fluid on the inside is 
separated from the fluid on the outside, is deformed 
it will change volume. This area is then the area the 
fluid is assumed to be pushed through when net 
volume is changed. 

Damping coefficient Like added mass, damping from wave generation 
can be introduced. This coefficient is multiplied with 
volume and velocity in the same way that the added 
mass coefficient is multiplied with acceleration. 

Include drift To include drift forces to the loads, “With slamming” 
under the Advanced tab in the Export dialog must be 
used.  
This element is calculated with forces to the actual 
water line, meaning that parts of drift forces are 
included even if this is not checked. 

Skin friction coefficient Drag along the membrane elements. 
Height of net edge Height of inside net, if 0.0 infinite height is set. If 

higher than 0.0 then the fluid inside can splash over 
the edge if it is compressed enough that it reaches 
over this set height.  

Inner fluid mass scaling Part of inner water mass inside tank to be used as 
added mass in the analysis.  
If this parameter is: 

- 1, then 100% of the enclosed water volume 
vibrates as added mass, 

- 0.2, then 20% of the enclosed water volume 
vibrates as added mass, 

- 0, then 0% of the enclosed water volume 
vibrates as added mass, 

- 1.2, then 120% of the enclosed water 
volume vibrates as added mass. 

More information is found in (Berstad A. J., The 
AquaSim package Theory user manual, 2021). 

Added mass indicator Indicator of added mass in and out of water. 
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0: Added mass both of fluid inside and outside are 
assumed distributed to the mean free surface and 
mass is distributed consistent (no mass in rotational 
DOFs).  The mean free surface is the surface at the 
steady state condition where approximately 2/3 of 
the current velocity has been added to the system. 
1: Same as 0, but the mass is lumped to the 
translational DOFs of the nodes. 
2: In this case added mass for both inside and 
outside fluid is calculated to the actual water line 
during the simulation. This option can be suitable for 
a stiff cylinder going in and out of water in a rather 
wall sided manner. 2 means combining with 
consistent mass. 
3: Same as 2 but combining with lumped mass. 

Extra drag in front Extra drag in front 
Wave damping tangential to panels The theoretical wave damping only works normal to 

the plane on the panel element, but in real life the 
panel may consist of some curvature meaning that a 
tangential part can be introduced. 

Combined pressure from waves and currents The way current and wave loads are combined for 
calculating pressure from current. 
0 means that the “raw” velocity at each element is 
used as basis such that the pressure is found from 
the pressure coefficient multiplied with relative 
velocity at the element. 1 means that the relative 
velocity is averaged over the elements at similar 
vertical location. In between means that the effects 
are weighted. 

Type of diffraction load Methods for calculating diffraction part of the 
pressure caused by waves. These are further 
explained in (Berstad A. , 2020). 
Flexible tarp: load formulation adapted to flexible 
tarps and woven textiles.  
MacCamy-Fuchs: Diffraction loads are calculated 
from the MacCamy-Fuchs theory, and the added 
mass and hydrodynamic damping factors are related 
to the volume of the tank. 
Numerical diffraction: Diffraction loads are based on 
numerical calculation(“sink-source”). Added mass 
and damping coefficients are in this case scaling the 
added mass which also is found from the numerical 
diffraction theory. 
Hybrid flexible tarp/numerical diffraction: 
Combination of the Flexible tarp- and Numerical 
diffraction-load formulations. Added mass and 
damping is calculated using the Numerical 
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diffraction-theory. The user weights the methods 
through the “Diffraction scaling” option. 
Hybrid flexible tarp/MacCamy-Fuchs: Combination 
of the Flexible tarp- and MacCamy-Fuchs load 
formulations. Added mass and damping is calculated 
using the MacCamy-Fuchs-theory. The user weights 
the methods through the “Diffraction scaling” 
option. 

Diffraction scaling Weight factor for the Hybrid flexible tarp/ numerical 
diffraction and Hybrid flexible tarp/ MacCamy-Fuchs 
formulations. Applying a value of 0.99 means that 
99% of the diffraction force is calculated from 
Numerical diffraction, or MacCamy-Fuchs, method. 
1% is taken from the Flexible tarp-method. 

Vacuum surface suction Vacuum between membrane and water line. For 
cases where membrane moves above water. 
- Ticked on, means activating vacuum. Negative 
pressure between membrane and water line is 
allowed. 
- Ticked off, means no vacuum. 

Thickness Y Thickness of twines in Y direction. Based on area of 
the threads and mask width that are given in the 
Information panel. The formula is thickness = Area / 
Mask width Y 
This can be overridden and the mask width in the 
Information panel will be updated accordingly. 

Thickness Z Thickness of twines in Z direction. 
Membrane thickness The total thickness, Y and Z direction added up. 
Sloshing Edit/Add a sloshing table to the net. 
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Figure 31 – Sloshing 

Properties Description 
Type Type of angles connected to the wave phase and 

direction: choose between radians or degrees. 
n The n-th sloshing wave. Each row represent a 

regular sloshing wave. 
Amplitude Amplitude of sloshing wave. 
Phase Wave phase in time relative to Sinus time.  

If set to -10 or less, then sloshing load is put on 
statically. 

Direction Wave direction relative to x-axis. 
Tank width Effective tank width. 
Tank depth Effective tank depth. 
Period Period of the sloshing wave [s]. Auto-calculated 

based on wave amplitude, tank width and tank 
depth. 

 

For a more detailed description of membrane parameters and its theory, see the report (Berstad A. J., 

The AquaSim package Theory user manual, 2021).  
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Figure 32 – Load properties, Morison free plate 

Morison free plate uses the Morison load formulation to calculate the load applied to the net elements. 

Properties Description 
Drag coefficient Drag coefficient on membrane, normal direction. 
Lift coefficient Coefficient for force on membrane, tangential 

direction. 
Added mass coefficient / height Added mass coefficient for the membrane, normal 

direction. Note that the unit is in [m], more 
information about this in (Aquastructures AS, 
2021g). 

Hydrodynamic damping coefficient Hydrodynamic damping is calculated along with the 
added mass. This parameter scales the calculated 
damping. If 1.0 all the calculated damping is 
included. If 0, nothing of the calculated damping is 
included. 

Skin friction coefficient Coefficient for skin friction force. Skin friction force 
is due to viscous drag in the boundary layer on the 
membrane.  

Added mass and damping Two options are available here: 
- Automatic: added mass and damping forces 

are calculated automatically by numerical 
method. 

- Manual: added mass and damping force are 
calculated manually based on the Added 
mass coefficient. The value in this case is 
height of water mass (i.e., multiplied with 
rho and area) whereas the coefficient for 
damping is multiplied with rho and area 
also. 

Wave amplitude reduction Reduction of wave amplitude on element, due to 
e.g., shadow effects. Input is a number between 0.0 
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and 1.0. 0 correspond to 0% reduction, 1.0 
correspond to 100% reduction 

Current reduction Reduction of current due to e.g., shadow effects. 
Input is a number between 0.0 and 1.0. 0 
correspond to 0% reduction, 1.0 correspond to 100% 
reduction. 

 

 

Figure 33 – Load properties, Lice skirt 

Properties Description 
Drag coefficient Gives the form drag to the cylinder with respect to 

the diameter of the cylindrically shaped net. 
Lift coefficient, peak value Gives the peak value for the pressure distribution. 
Added mass coefficient Added mass coefficient horizontal motion with 

respect to 2D volume with the diameter at the given 
depth. 

Hydrodynamic damping coefficient Added mass coefficient vertical motion with respect 
to 2D volume with the diameter at the given depth. 

Damping coefficient Like added mass, damping from wave generation 
can be introduced. This coefficient is multiplied with 
volume and velocity in the same way that the added 
mass coefficient is multiplied with acceleration. 
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Include drift To include drift forces to the loads, “With slamming” 
under the Advanced tab in the Export dialog must be 
used.  
This element is calculated with forces to the actual 
water line, meaning that parts of drift forces are 
included even if this is not checked. 

Skin friction coefficient Drag along the membrane elements. 
Inner fluid mass scaling Part of inner water mass inside tank to be used as 

added mass in the analysis.  
If this parameter is: 

- 1, then 100% of the enclosed water volume 
vibrates as added mass, 

- 0.2, then 20% of the enclosed water volume 
vibrates as added mass, 

- 0, then 0% of the enclosed water volume 
vibrates as added mass, 

- 1.2, then 120% of the enclosed water 
volume vibrates as added mass. 

More information is found in (Berstad A. J., The 
AquaSim package Theory user manual, 2021). 

Added mass indicator Indicator of added mass in and out of water. 
0: Added mass both of fluid inside and outside are 
assumed distributed to the mean free surface and 
mass is distributed consistent (no mass in rotational 
DOFs).  The mean free surface is the surface at the 
steady state condition where approximately 2/3 of 
the current velocity has been added to the system. 
1: Same as 0, but the mass is lumped to the 
translational DOFs of the nodes. 
2: In this case added mass for both inside and 
outside fluid is calculated to the actual water line 
during the simulation. This option can be suitable for 
a stiff cylinder going in and out of water in a rather 
wall sided manner. 2 means combining with 
consistent mass. 
3: Same as 2 but combining with lumped mass. 

Extra drag in front Extra drag in front 
Wave damping tangential to panels The theoretical wave damping only works normal to 

the plane on the panel element, but in real life the 
panel may consist of some curvature meaning that a 
tangential part can be introduced. 

Combined pressure from waves and currents The way current and wave loads are combined for 
calculating pressure from current. 
0 means that the “raw” velocity at each element is 
used as basis such that the pressure is found from 
the pressure coefficient multiplied with relative 
velocity at the element. 1 means that the relative 
velocity is averaged over the elements at similar 
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vertical location. In between means that the effects 
are weighted. 

Type of diffraction load Methods for calculating diffraction part of the 
pressure caused by waves. These are further 
explained in (Berstad A. , 2020). 
Flexible tarp: load formulation adapted to flexible 
tarps and woven textiles.  
MacCamy-Fuchs: Diffraction loads are calculated 
from the MacCamy-Fuchs theory, and the added 
mass and hydrodynamic damping factors are related 
to the volume of the tank. 
Numerical diffraction: Diffraction loads are based on 
numerical calculation(“sink-source”). Added mass 
and damping coefficients are in this case scaling the 
added mass which also is found from the numerical 
diffraction theory. 
Hybrid flexible tarp/numerical diffraction: 
Combination of the Flexible tarp- and Numerical 
diffraction-load formulations. Added mass and 
damping is calculated using the Numerical 
diffraction-theory. The user weights the methods 
through the “Diffraction scaling” option. 
Hybrid flexible tarp/MacCamy-Fuchs: Combination 
of the Flexible tarp- and MacCamy-Fuchs load 
formulations. Added mass and damping is calculated 
using the MacCamy-Fuchs-theory. The user weights 
the methods through the “Diffraction scaling” 
option. 

Diffraction scaling Weight factor for the Hybrid flexible tarp/ numerical 
diffraction and Hybrid flexible tarp/ MacCamy-Fuchs 
formulations. Applying a value of 0.99 means that 
99% of the diffraction force is calculated from 
Numerical diffraction, or MacCamy-Fuchs, method. 
1% is taken from the Flexible tarp-method. 

Thickness Y Thickness of twines in Y direction. Based on area of 
the threads and mask width that are given in the 
Information panel. The formula is thickness = Area / 
Mask width Y 
This can be overridden and the mask width in the 
Information panel will be updated accordingly. 

Thickness Z Thickness of twines in Z direction. 
Membrane thickness The total thickness, Y and Z direction added up. 
Sloshing Edit/Add a sloshing table to the net. More 

information in Figure 31 and succeeding table after 
the mentioned figure. 
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Figure 34 – Load properties, Closed compartment 

 

Properties Description 
Drag coefficient Gives the form drag to the cylinder with respect to 

the diameter of the cylindrically shaped net. 
Lift coefficient, peak value Gives the peak value for the pressure distribution. 
Density of fluid inside tank If the bottom factor is 0.0 (e.g., lice skirt), this 

parameter is a dummy. In this case the internal 
static pressure is set equal to the external pressure. 
If the bottom factor is 1.0, then this parameter is the 
density of the fluid inside the tank. The external 
pressure is calculated based on the density of salt 
water, 1025 kg/m3 

Height of fluid level inside tank relative to 
sea level 

This parameter is a dummy if the bottom factor is 
0.0. 
If the bottom factor is 1.0 then this value is the static 
water level of the fluid inside the tank, relative to 
the outside water level. Positive value means that 
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the inside water level is higher than the outside 
water level. 
This * area top gives the extra volume. 

Added mass coefficient / height Added mass coefficient for the membrane, normal 
direction. Note that the unit is in [m], more 
information about this in (Aquastructures AS, 
2021g). E.g., if a tank has ha radius of 25m, and the 
mass coefficient 𝐶𝑀 = 1, then we have 25m of 
added mass. 

Hydrodynamic damping coefficient Added mass coefficient vertical motion with respect 
to 2D volume with the diameter at the given depth. 

Bottom factor, 0 if water flow through 
bottom 

1.0 means that the inner volume is separated from 
the outer volume. 0.0 means that the inside and the 
outside fluids are connected, which is the case for 
lice skirts. 

Area top that water can penetrate over This parameter is a dummy if the bottom factor is 
0.0. 
When a net, where the fluid on the inside is 
separated from the fluid on the outside, is deformed 
it will change volume. This area is then the area the 
fluid is assumed to be pushed through when net 
volume is changed. 

Damping coefficient Like added mass, damping from wave generation 
can be introduced. This coefficient is multiplied with 
volume and velocity in the same way that the added 
mass coefficient is multiplied with acceleration. 

Include drift To include drift forces to the loads, “With slamming” 
under the Advanced tab in the Export dialog must be 
used.  
This element is calculated with forces to the actual 
water line, meaning that parts of drift forces are 
included even if this is not checked. 

Skin friction coefficient Drag along the membrane elements. 
Height of net edge Height of inside net, if 0.0 infinite height is set. If 

higher than 0.0 then the fluid inside can splash over 
the edge if it is compressed enough that it reaches 
over this set height.  

Inner fluid mass scaling Part of inner water mass inside tank to be used as 
added mass in the analysis.  
If this parameter is: 

- 1, then 100% of the enclosed water volume 
vibrates as added mass, 

- 0.2, then 20% of the enclosed water volume 
vibrates as added mass, 

- 0, then 0% of the enclosed water volume 
vibrates as added mass, 

- 1.2, then 120% of the enclosed water 
volume vibrates as added mass. 
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More information is found in (Berstad A. J., The 
AquaSim package Theory user manual, 2021). 

Added mass indicator Indicator of added mass in and out of water. 
0: Added mass both of fluid inside and outside are 
assumed distributed to the mean free surface and 
mass is distributed consistent (no mass in rotational 
DOFs).  The mean free surface is the surface at the 
steady state condition where approximately 2/3 of 
the current velocity has been added to the system. 
1: Same as 0, but the mass is lumped to the 
translational DOFs of the nodes. 
2: In this case added mass for both inside and 
outside fluid is calculated to the actual water line 
during the simulation. This option can be suitable for 
a stiff cylinder going in and out of water in a rather 
wall sided manner. 2 means combining with 
consistent mass. 
3: Same as 2 but combining with lumped mass. 

Extra drag in front Extra drag in front 
Wave damping tangential to panels The theoretical wave damping only works normal to 

the plane on the panel element, but in real life the 
panel may consist of some curvature meaning that a 
tangential part can be introduced. 

Combined pressure from waves and currents The way current and wave loads are combined for 
calculating pressure from current. 
0 means that the “raw” velocity at each element is 
used as basis such that the pressure is found from 
the pressure coefficient multiplied with relative 
velocity at the element. 1 means that the relative 
velocity is averaged over the elements at similar 
vertical location. In between means that the effects 
are weighted. 

Type of diffraction load Methods for calculating diffraction part of the 
pressure caused by waves. These are further 
explained in (Berstad A. , 2020). 
Flexible tarp: load formulation adapted to flexible 
tarps and woven textiles.  
MacCamy-Fuchs: Diffraction loads are calculated 
from the MacCamy-Fuchs theory, and the added 
mass and hydrodynamic damping factors are related 
to the volume of the tank. 
Numerical diffraction: Diffraction loads are based on 
numerical calculation(“sink-source”). Added mass 
and damping coefficients are in this case scaling the 
added mass which also is found from the numerical 
diffraction theory. 
Hybrid flexible tarp/numerical diffraction: 
Combination of the Flexible tarp- and Numerical 
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diffraction-load formulations. Added mass and 
damping is calculated using the Numerical 
diffraction-theory. The user weights the methods 
through the “Diffraction scaling” option. 
Hybrid flexible tarp/MacCamy-Fuchs: Combination 
of the Flexible tarp- and MacCamy-Fuchs load 
formulations. Added mass and damping is calculated 
using the MacCamy-Fuchs-theory. The user weights 
the methods through the “Diffraction scaling” 
option. 

Diffraction scaling Weight factor for the Hybrid flexible tarp/ numerical 
diffraction and Hybrid flexible tarp/ MacCamy-Fuchs 
formulations. Applying a value of 0.99 means that 
99% of the diffraction force is calculated from 
Numerical diffraction, or MacCamy-Fuchs, method. 
1% is taken from the Flexible tarp-method. 

Thickness Y Thickness of twines in Y direction. Based on area of 
the threads and mask width that are given in the 
Information panel. The formula is thickness = Area / 
Mask width Y 
This can be overridden and the mask width in the 
Information panel will be updated accordingly. 

Thickness Z Thickness of twines in Z direction. 
Membrane thickness The total thickness, Y and Z direction added up. 
Wave amplitude reduction Reduction of wave amplitude on element, due to 

e.g., shadow effects. Input is a number between 0.0 
and 1.0. 0 correspond to 0% reduction, 1.0 
correspond to 100% reduction 

Current reduction Reduction of current due to e.g., shadow effects. 
Input is a number between 0.0 and 1.0. 0 
correspond to 0% reduction, 1.0 correspond to 100% 
reduction. 

Sloshing Edit/Add a sloshing table to the net. More 
information in Figure 31 and succeeding table after 
the mentioned figure. 
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Figure 35 – Load properties, Surface tarpaulin 

 

Properties Description 
Drag coefficient Drag coefficient on membrane, normal direction. 
Added mass coefficient / height Added mass coefficient for the membrane, normal 

direction. Note that the unit is in [m], more 
information about this in (Aquastructures AS, 
2021g). 

Hydrodynamic damping coefficient Hydrodynamic damping is calculated along with the 
added mass. This parameter scales the calculated 
damping. If 1.0 all the calculated damping is 
included. If 0, nothing of the calculated damping is 
included. 

Suction coefficient Coefficient for suction effect between the tarpaulin 
and water surface. The tarp will stick to the 
waterline and follow the water particle motion. 

Skin friction coefficient Coefficient for skin friction force. Skin friction force 
is due to viscous drag in the boundary layer on the 
membrane.  

Added mass indicator Indicator of added mass in and out of water. 
0: Added mass both of fluid inside and outside are 
assumed distributed to the mean free surface and 
mass is distributed consistent (no mass in rotational 
DOFs).  The mean free surface is the surface at the 
steady state condition where approximately 2/3 of 
the current velocity has been added to the system. 
1: Same as 0, but the mass is lumped to the 
translational DOFs of the nodes. 
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2: In this case added mass for both inside and 
outside fluid is calculated to the actual water line 
during the simulation. This option can be suitable for 
a stiff cylinder going in and out of water in a rather 
wall sided manner. 2 means combining with 
consistent mass. 
3: Same as 2 but combining with lumped mass. 

Tangential added mass coefficient Added mass coefficient in tangential direction of the 
surface tarpaulin. More information is found in 
(Berstad A. J., The AquaSim package Theory user 
manual, 2021) 

Type of diffraction load Methods for calculating diffraction part of the 
pressure caused by waves. These are further 
explained in (Berstad A. , 2020). 
Froude Kriloff: when forces is calculated by “Froude-
Kriloff” this means that pressure to the surface 
tarpaulin is calculated from the undisturbed incident 
wave, and it is assumed that the tarpaulin causes 
neglectable diffraction.  
Numerical diffraction: Diffraction loads are based on 
numerical calculation(“sink-source”). Added mass 
and damping coefficients are in this case scaling the 
added mass which also is found from the numerical 
diffraction theory. 

Wave amplitude reduction Reduction of wave amplitude on element, due to 
e.g., shadow effects. Input is a number between 0.0 
and 1.0. 0 correspond to 0% reduction, 1.0 
correspond to 100% reduction 

Current reduction Reduction of current due to e.g., shadow effects. 
Input is a number between 0.0 and 1.0. 0 
correspond to 0% reduction, 1.0 correspond to 100% 
reduction. 
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Bending stiffness 

 
Figure 36 - Bending stiffness panel 

Properties Description 
E-modulus vertical Young’s modulus for vertical threads (Young’s modulus in the information 

tab is for horizontal threads). 
Area vertical Cross-sectional area for vertical threads (Area in the information tab is for 

horizontal threads). 
G-modulus horizontal Shear modulus for horizontal threads. 
G-modulus vertical Shear modulus for vertical threads. 
Ix horizontal Moment of area around local x-axis for horizontal threads. 
Ix vertical Moment of area around local x-axis for vertical threads. 
Iz horizontal Moment of area around local z-axis for horizontal threads. 
Iz vertical Moment of area around local z-axis for vertical threads. 
It horizontal Torsional stiffness for horizontal threads. 
It vertical Torsional stiffness for vertical threads. 
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2.14.5  Explicit membrane 
The membrane_x component type (explicit membrane) is a specialized type of membrane that does not 

automatically detect its membrane elements based on surrounding elements. Each quad is explicitly 

drawn. It also allows for drawing triangles.  

Membrane_x can be accessed by right click a new component in the Components window > Type > 

Membrane_X. 

It is possible to convert a normal membrane to an explicit one. All pre-existing elements will be 

converted to explicit membrane elements. 

Other advantages of using explicit membranes are to avoid collision with other components, leading to 

erroneous membrane element generation. This can happen with e.g., ropes attached to membranes or 

attachments to floating elements.  

Explicit membranes are also much faster when dealing with larger models. 

See chapters 3.17, 3.19 and 5.4 for more information on how to use the explicit membrane type. 
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2.14.6  Hexagonal/ 6-sided membrane 

Note: Membrane 6 components are still under development and testing, any 

functionality may change in future versions. 

 

Figure 37 - Extra properties for Membrane 6 components 

Hex nets are nets with hexagonal (6) sides. They are modelled with 6 sides where each side will 

represent several small hexes. 

Note: When modelling hexes every modelled hex must have the same form. Small deviances can be 

tolerated, but the more skewed the worse the results will be. 

See chapter Generate hex to learn more about 6-sided membranes and how to generate them. 
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2.14.7  Truss 
Truss has a lot in common to beam, the main difference is that a truss element does not have bending 

or torsional resistance. 

Information 

 

Figure 38 - Information panel 

 

Properties Description 
Name Name of the component. 
Description Description of the component. 
E-modulus Young’s modulus. 
Area Cross-sectional area. 
Diameter Cross-sectional diameter. Calculated based on the input area. 
Volume Volume of truss, default value equals area. 
Mass density Mass density. 
Weight in air Weight when not submerged. 
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Weight in water Weight when submerged, default value Weight in air – (volume 
* density of water). 

Diameter Y/Z Drag area is calculated from diameter * length of element. 
Drag coefficient Y/Z Drag coefficients for local y- and z-axis 
Added mass coefficient Y/Z Added mass coefficients for local y- and z-axis 
No compression forces Use this if truss elements should not take compression forces. 
Pretension Pre-strain, elongation divided by the length of the element. 

Positive value will shorten the element, giving stretch forces. 
Breaking load Breaking load of truss for calculating utility factor. 
Material coefficient Material factor for truss for calculating utility factor. 
Rayleigh damping (mass/stiffness) Same as for beam, see chapter Material/section properties. 
Longitudinal drag coefficient Friction coefficient for drag in local x-axis. 

 

Wind load is the same as for beam, see chapter Wind load for more details. 

Damper 

 

Figure 39 - Damper panel 

Activate this if component is a bar damper. A bar damper is an element where the internal force is 

proportional to the relative velocity between the elements’ endpoints instead of the relative position. 

The maximum and minimum force values put a “cap” on the internal forces in the bar such that the 

internal forces stay within the limit also if forces reach above these values. 

Advanced 

It is possible to add a non-linear table to the truss. More information about non-linear tables, see 

chapter Node2Node spring. Note: Only Strain and Axial Force is available for non-linear data on trusses. 
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2.14.8  Node2Node spring 
A component can also be a node2node 

spring, which is a spring connected between 

two nodes with a stiffness and stiffness 

rotation given as input.  

The type can also be TYPE14, which has input 

damping and damping rotation. 

For linear springs the relation between force 

and stiffness is given as F = k*r, which is 

Hooke’s Law. The springs can also be non-

linear, where the user needs to add a non-

linear table instead in the field “Non linear 

data” (see below). All non-linear tables can be 

found in Tools > Show non linear 

data tables. 

 

 

 

Figure 41 - Properties for non-linear data 

The input here is a table where the user can input a relation between displacement and force, and 

relation between moment and rotation.  

Figure 40 - Properties for node2node spring component 
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3. Functions and intents 
As mentioned in chapter Terminology, an intent is a function in AquaEdit e.g. Draw line, Split line, 

Measure angle etc.  

Node snapping 

The snap function is toggled by pressing the Snap button on the toolbar. If this button is highlighted, 

most drawing functions will attempt to snap to a nearby node when drawing. If the distance to the 

closest node is too large, the attempt will fail, and nothing will happen. 

If the user holds down ALT whilst clicking the snap function is inversed. 

Position snapping 

Snapping can also be done against the nearest corner of the grid by holding down SHIFT, snap must be 

disabled for this to work. 

Keyboard input 

 

Figure 42 - Keyboard input fields 

By filling in the X, Y and Z fields and then pressing ENTER the keyboard input will be used instead of a 

mouse click. Keyboard input is not affected by node snapping or position snapping.  

When using the keyboard input the X, Y and Z fields can also be made relative from the last used 

position by holding SHIFT as the ENTER key is pressed, or by enabling the relative position indicator. 

Calculator in input fields 

Some input fields can use a calculator to calculate values, usually valid in the fields for beam, truss, 

membrane and node2node components where the input values are of floating numbers. To enable the 

calculator, write “=” at the start of the input. Figure 43 shows an example in the field for E-modulus for a 

truss component. At the right end of the field there will be a preview of what the final calculation will 

be. The functions available now are: 

+, -, *, /, ^, sin(radians), cos(radians), sindeg(degrees), cosdeg(degrees), pi, abs(number),      

max(number1 number2), min(number1 number2). There is also round(number) which will round the 

number in the parenthesis to the lowest integer, i.e. round(2*cosdeg(45)) will return 1 since the number 

within the parenthesis will be 1.4142. 
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Figure 43 - Example of calculator in input field 

3.1 Draw line 
The most basic function draws a line between two new or existing nodes. By default, the line will be 

drawn continuous.  

Single line mode: This will automatically start a new non-connected line after each line is drawn. 

Input heading: After the first node is drawn the user can input a heading (anti-clockwise from the x-axis) 

and a length to automatically create a line based on 

this. 

A line can be cancelled by pressing ESC (pressing ESC 

while before the first node is created will cancel the 

intent and revert to the Pointer intent). This will cancel 

the current line and let the user select a new starting 

node for the line. 
Figure 44 - Draw line properties 
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By holding CTRL when clicking (while snap is off) the intent will split the closest line (if there is any) and 

create a new node her, joining the three lines. 

3.2 Draw rectangle 
Draw rectangle takes 3 nodes and creates a rectangle. These nodes can be either drawn or snapped 

using the snap functions available.  

Holding down CTRL when dragging/selecting the third node will project the rectangle so an equilateral 

rectangle is created instead of (potentially) a rhombus, see Figure 45. 

 

Figure 45 - Rectangle drawn as a rhombus on the left, rectangle drawn as an equilateral rectangle on the right 

3.3 Draw grid 
A rectangle can be drawn pre-spliced into smaller rectangles – a grid. This is especially useful for square 

or odd-shaped components. Compatible for all component types. 

The number of slices in the two directions is given as 

input in the tool properties window. Any lines parallel to 

the outside lines of the rectangle will be split to match 

the intersections of the segments inside the rectangle. 

 

Figure 47 – A 2 x 4 grid 

Figure 46 - Setting divisions of a 
membrane rectangle 
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3.4 Draw circle 
Circles in AquaEdit will be divided into elements with equal lengths. Using the draw intent, the user can 

input the radius and the number of segments 

the user wants the circle divided into. The 

circumference will update automatically based 

on the radius, the user can also input the 

circumference directly instead of the radius. 

The circle will be drawn with the given input 

when the user left clicks on the canvas or using 

keyboard input described in chapter Keyboard input. The circle 

will be drawn in the view that is currently active, view ISO will 

draw the circle in the x-y-plane. 

Using the mouse, the user can also drag the size of the circle by holding down the left mouse button on 

the canvas. This will snap to nodes if node snapping is enabled. The radius can be made to match the 

distance between the center of the circle and a previously drawn node if snap is one when the user 

releases the mouse button. A live preview will be visible when dragging the mouse. 

3.5 Draw tube 
Drawing intent that creates tube for explicit membranes 

(Membrane X) and truss elements. This intent is similar as Draw 

circle. In addition, the user inputs the length of the tube (i.e., the 

height), number of segments in the length-direction. An option 

for different radius at the bottom of the tube may be activated 

by toggle the Bottom radius. 

The tube will be drawn with the given input when the user left 

clicks in the canvas (3D view) or using keyboard input as 

described in chapter Keyboard input. The tube will be drawn in 

the view that is currently active, with the Length-axis pointing 

normal to the drawing view. For ISO- and XY-view the length axis 

is along the Z-axis.  

3.6 Move 
Selected nodes, elements and quads can be moved by using the move intent. To enable moving, either 

nodes or elements must be selected, then the user selects a “source” node for the move operation. 

Selecting a “source” node is done by clicking on or near a node that is part of the selection that is to be 

moved. If the selection is moved while snapping is enabled the “source” node will be the part that is 

snapped to another node. 

Figure 48 - Properties for drawing 
circles 

Figure 49 - Properties for drawing tube 
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Elements will be disconnected from the original position, while moving nodes will keep any line 

connections they may have had (see Figure 50). 

 

Figure 50 - Moved elements on the left, moved nodes on the right 

Keyboard input can also be used to move the selection. 

Selected elements can be copied instead of moved; this is done by holding down CTRL when clicking the 

selections into place. 

3.7 Rotate 
To rotate a selection a pivot point (the point of rotation) and the rotation in degrees must be given as 

input. When the rotate intent is activated, the pivot point will be set to the center of the selection by 

default. 

The pivot point can be changed by either entering the 

point manually in the properties windows or by mouse 

click. If mouse click is used, then the current snap 

status will be used. Use mouse click with snap 

activated if it is required to rotate around an existing 

node. 

Figure 51 - Properties for rotate 
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Figure 52 – Left: Before rotation. Middle: Rotation around center of selection. Right: Rotation around node 

Note that rotation is done from left to right, though it is best to use multiple rotations if more than one 

axis is needed for the rotation. The rotation input is for the opposite axis of the view, i.e. when in top 

view (x, y) a rotation of 0, 0, 45 will rotate the selection 45 degrees clockwise when looking straight 

down (seeing “into” the z-axis).  

Together with Pivot point the selections “From” and “To” creates a local rotation plane that can be 

applied if not the default global planes are appropriate. 

3.8 Scale 
When using the scale intent, the mouse can be dragged to scale the selection in the current view (i.e. 

the x- and y-axis when in top view). In the scale intent the pivot point will be set to the center of the 

selection by default. 

Alternatively, the keyboard input can be used to scale the selection in 

all three axes. If scaling in an axis is unwanted, use 1 for no scaling. 

 

Figure 53 - Properties for scaling 
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Figure 54 - Scaling of a circle 

Figure 54 shows how scaling of a circle will look like if pivot point is in the center of the circle and the 

scaling is 1 for y- and z-axis while it is 2 for x-axis.  

3.9 Duplicate 
A selection can be duplicated and transformed 

using the duplicate intent. Note: Extrude intent 

works in the same way, the difference being 

that duplicated elements will become connected 

with new lines between them. 

Segments 

How many duplicates to make. 

Vector 

The vector distance (translation) of each 

duplicated segment. 

Scale 

Optionally scale the selection for each segment.  

Rotate 

Optionally rotate the selection for each 

segment, input in degrees. 

Alternatively rotate around a pivot point. 
Figure 55 - Properties for duplicate 
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New components 

This option will put the duplicated segments in its own component. 

Each segment 

This option will put each duplicated segment in its own component. 

Copy decorators 

Copy decorators from the original selection to the duplicated selection. 

 

Figure 56 - Left: Before duplicate. Middle: With vector translation. Right: With vector translation, scaling and new components 

3.10 Extrude 
For the functionality, see chapter about duplicate above. Note: Vector is here based on the origin of the 

segment before. 

 

Figure 57 - Left: Exruded segments with connecting segments. Right: Two extrude operations, the second with scale 0.1, 0.1, 1 

Each connecting segment 

Only available when using extrude. Each connecting segment will be put in its own component. 
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3.11 Mirror 
When mirror a selection a mirror line must be given as input. This 

can be done by entering the points manually or by using the 

mouse. When using the mouse; first click gives the first point and 

second click gives second point. A mirror line will be made from 

these points when executing this intent. 

The mirror line can be snapped by either using node snapping or 

position snapping. 

 

Figure 59 - Mirroring two lines to make a square. Mirror line given by using snap on the two end nodes on the existing line 

3.12 Split line 
Existing lines can be split using the split line 

intent. Input is the number of segments or a 

distance from an existing node. 

There are four ways to split lines.  

1. Using “Split selection” to split the 

selected elements. 

2. Clicking on an element will split the line 

in the segments given in the input, provided that “Split at distance” is not checked. 

3. Clicking on an element with “Split at distance” checked will split the element in two with the 

new line having a distance equal to input. The new line will be created to the closest node of the 

mouse click 

4. Holding CTRL and using the mouse will create new nodes where the mouse pointer is. 

Figure 58 - Properties for mirror 

Figure 60 - Properties for split line 
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Figure 61 - Three different ways of splitting 

Figure 61 shows three different ways of splitting a line:  

Vertical line on the left is split using method 1 or 2. Horizontal line on bottom is split using method 3. 

Horizontal line on top is split using method 4. 

3.13 Intersect lines 
The intersect lines intent can be used to split and join lines that 

are drawn. Every intersection found in the current selection will 

be attempted split and each line will be joined into that split. 

Figure 63 shows two lines that intersect each other. A new node 

will be created in that intersection and we are left remaining with 

four connecting elements. 
Figure 62 - Properties for intersect lines 
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Figure 63 - Left: Two lines with intersection. Right: Lines split into four new connecting lines 

3.14 Merge lines 
Lines that are laid out in the same direction can be merged 

together to a single line using the merge lines intent. The 

lines need to have the same angle, meaning they must lay 

directly after another. 

 

 

Figure 65 - Left: Elements in the same direction. Right: After merging the lines 

Figure 64 - Properties for merge lines 
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3.15 Measure distance 
The distance between two nodes can be calculated using the measure distance intent.  

 

Figure 66 - Properties for measure distance 

Select the start- and end node to calculate the distance between the nodes. The input in the dialog will 

be filled in by the two first selected nodes if the user has a selection of nodes on the canvas. 

3.16 Measure angle 
Measuring angles of an element and between elements can be done using the measure angle intent. 

 

Figure 67 - Left: Properties for measure angle. Right: Results of measure angle 

The input in the dialog will be filled in by the first two selected elements if the user has a selection of 

elements on the canvas. 

3.17 Select quad(s) 
Explicit membranes have its own selecting tool, Select quad element. This tool allows the user to select, 

delete or modify quad elements. Figure 68 shows a quad element that is selected.  

The following selection options are available: 

- Left click inside a quad: the quad is selected. 

- Left click + hold + drag to the left: any quad elements that have a node inside the box area is 

selected. 

- Left click + hold + drag to the right: any quad elements that have all nodes inside the box area is 

selected. 
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When selecting an explicit quad 

element you will be able to see the 

horizontal and vertical edges by the 

color of the nodes (be careful when 

selecting more than one element if 

you are interested in the edges, since 

the color of the nodes can be 

overwritten by nearby elements). 

The nodes are numbered in the 

order of red, green, blue and yellow. 

The red to green edge is the first 

horizontal edge, green to blue the 

first vertical edge. Blue to yellow is 

the second horizontal edge, yellow 

to red the second vertical edge. The 

horizontal edges also shown as a stippled line. Note that these must be drawn correctly for net forces to 

be calculated correctly. 

In the case of triangular membrane elements, the internal representation looks slightly different, with 

node 3 equal to node 1 to indicate that it isn’t rectangular.  

3.18 Subdivide quad(s) 
Explicit membranes (Membrane_X) has its own tool for subdividing elements. This tool allows the user 

to subdivide in several directions: 

- Subdivide: subdivide the selected quad in horizontal and vertical direction in one operation. 

- Subdivide vertical: subdivide the selected quad about the quad’s vertical axis. 

- Subdivide horizontal: subdivide the selected quad about the quad’s horizontal axis. 

- Triangulate: subdivide the selected quad along the quad’s diagonal, in such that two triangles 

are generated. 

These options are shown in Figure 69. 

 

Figure 69 - Subdivide options for quad(s) 

In order to access the subdivide tool, the user must first select the relevant quad(s) by applying e.g., the 

Select quad(s) tool. 

Figure 68 – Quad elements selected 
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3.19 Draw membrane 
Explicit membranes have its own drawing tool. It has the option to draw quads or 

triangles. When using explicit membranes, it is important to get the vertical and 

horizontal edges correct, as the tool does not do these corrections for the user. 

The tool will prompt the user on which axis to draw, see Figure 71. It will be the 

vertical edge first, then the horizontal edge, back to the 

second vertical edge and, in the case of quads, the second 

horizontal edge last. 

3.19.1 Twine direction in explicit membranes 
In quad elements, the twines are organized in the same 

manner as Mask Type 1 for conventional membranes. The 

twines will cross perpendicular to the horizontal edge of the 

quad element. This is illustrated to the left in Figure 72, where the green grid representing the twines, 

and the blue lines are the quad element. The dashed line is the horizontal edge of the quad element, 

and the solid line is the vertical edge.  

 

Figure 72 - Twine direction in quad- and triangle elements 

Triangle elements are similar (right in Figure 72), the twines cross perpendicular to the horizontal edge 

of the triangle element. The diagonal (i.e., solid line between green and yellow node) will cross the 

twine’s diagonal. 

  

Figure 70 – Properties 
for draw membrane 

Figure 71 - Prompting user for edge input 



   

69 
AquaSim 2.17 

3.20 Selecting 
There are several tools for selecting in AquaEdit. The main selection tool is the pointer which covers the 

most usage, see chapter Interacting with the 3D model. The pointer is activated by default when 

opening AquaEdit. It may be selected pressing ESC (sometime a couple times) or selecting it from the 

toolbar. 

Select all/deselect all 

To use select all press CTRL+A when on the canvas. It will automatically select all elements, or all nodes 

based on what is selected on the canvas. If nothing is selected the function will select all elements. 

Select all is also available in EDIT->Select All. 

To deselect everything press CTRL+U, use the menu Edit > Select none or press ESC when the 

pointer is activated. 

Pointer 

The Pointer intent provides several selection 

modes. Having selected the Pointer, the Tool 

properties window will provide access to the 

selection modes, see Figure 70.  

- Mixed: selects only line elements (i.e., 

excluding quads) and nodes. 

- Elements: selects only line elements. 

- Quads: selects only quad elements 

(associated with membraneX). 

- Elements and Quads: selects both 

elements and quads in one operation. 

- Nodes: selects only nodes. 

Additive selection means that new selections are 

added for each time the mouse pointer is released 

and pressed again in the 3D-view. 

By clicking in the 3D-view, the nearest line or node will be selected. 

A box selection can be used by clicking and dragging the left mouse button across the canvas. The drag 

direction matters when deciding what lines to include. Dragging from left to right will select lines that 

are completely covered by the quad, dragging from right to left will select all lines that has one or both 

nodes within the quad. 

If you wish to select nodes instead of lines when dragging, hold SHIFT while dragging. 

To add or remove to the current selection, hold CTRL when clicking. You can also add to the selection by 

holding CTRL while dragging, but dragging cannot be done to remove from the selection. 

Holding ALT while making a box selection will zoom in on the elements within the selection. 

Figure 73 - Pointer selection in Tool properties window 
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On models that are especially large or small it may become necessary to tweak the values controlling 

whether nodes or lines are selected with the pointer. In these cases, the snap modifier can be set to i.e., 

0.1 to allow easier selection of elements. 

 

Figure 74 - Snap modifier 

Select node(s) 

Select node will limit all selection to just nodes. 

Select element(s) 

Select element will limit all selection to just lines. 

Select component 

Select component will select all lines belonging to the same component as the lines selected with this 

tool. 

Box select 

Selects elements that are inside the box that is created by either click + drag to the left or, click + drag to 

the right on the canvas.  

Select quad 

Selects all within a quad. Same as with pointer, but cannot use CTRL to add to selection or ALT to zoom. 

3.21 Rotate view 
This gives left mouse button the ability to rotate around on the canvas; it gives left mouse button same 

function as the middle mouse button. 
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4. Property editing 
AquaEdit allows editing of all aspects of properties of nodes, elements, hinges, point loads etc. that are 

possible in AquaSim. 

4.1 Nodes 
Displays name, global coordinates and degrees of 

freedom (DOF) for selected node(s). These can also be 

edited directly in the panel. If a terrain is imported, 

then the GPS-position is shown here too. The …-button 

in the GPS-field opens the location in Google Maps in 

your browser. The GPS-position can also be set to a 

different type, see chapter Settings. 

The global coordinates can be edited by clicking the  

…-button on the Location-property. 

Selection and de-selection of all DOFs in one click can 

be done by selecting the right-most checkbox. The panel 

also shows all decorators added to the node. The 

decorators can be edited by clicking the …-button and removed by clicking the X-button. 

 

Figure 76 - Context menu for nodes 

Figure 76 shows the menu when the mouse is right clicked in the draw window. This menu gives the 

possibility to add new or existing decorator to nodes. The same menu, excluding Remove-menu, is 

found in the popup-menu for the Node property panel shown in Figure 75 and the menu Commands > 

Nodes. The menu “Bind shape to element” will only appear if the node has a Shape added to it. The 

menu “Snap node to terrain” will only appear if the model has a terrain imported.  

Figure 75 - The node property panel 
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4.1.1 Degrees of freedom 
DOF can be set by selecting the nodes(s) you want to edit and checking on/off the boxes in the Node 

property panel, shown in Figure 64. The first three boxes correspond to translation in x-, y- and z-

direction. The last three boxes correspond to rotation about the x-, y-, and z-axis. 

4.1.2 Pointloads 
Point loads and momentums work according 

to the global coordinate system. These are 

static loads and will be added to the model in 

the first step. 

Three translational forces in x-, y- and z-

direction can be assigned, as well as three 

rotational moments in x-, y- and z-direction. 

For information about the different load 

types, see (Berstad A. J., The AquaSim 

package Theory user manual, 2021). 

 

 

 

 

4.1.3 RAO on Pointloads 
It is also possible to connect a RAO to the Pointload. Available RAO types are: 

- Normal 

- Drift polar 

- Drift cartesian 

To include RAO, a RAO-table must be established. These can be added using the dropdown menu and 

selecting “(new)”. Settings for the RAO table is described below, these are similar for Normal, Drift 

cartesian and Drift Polar. The RAO-tables can also be edited in the menu Tools > Tables > Show 

RAO tables. For information about the different RAO types, see (Berstad A. J., The AquaSim package 

Theory user manual, 2021). 

Properties Description 
Name Name of the table. 
Symmetric Activates symmetry in the RAO tables. If RAO tables are defined for 0-180 

degrees, selecting “Symmetric” checkbox AquaSim will apply equivalent 
tables for 180-360 degrees. 

Angle of 0 direction The angle of 0 direction in the RAO. 
Type Indicator as to the RAO shall be given in terms of Wave frequency (WF), 

Hertz (Hz), Wave period (WP) or Time. 
Indicator of wave angle Indicator as to whether angles is given in radians or degrees. 
Indicator of phase angle Indicator as to phase angles in RAO shall be added or subtracted. 

Figure 77 - Properties for pointload 
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Indicator of rotations Indicator as to how the operator for rotations is given: 
Radians per unit wave elevation. 
Degrees per unit wave elevation. 
Relative to the steepness of the wave.  

 

RAO Type: Normal 

For RAO type Normal, RAOs are defined in terms of force, moment and direction. When RAO-table Type 

WF, Hz or WP is chosen, the RAO-table will look like Figure 78. Parameters are elaborated in the 

succeeding table.  

 

Figure 78 RAO-table for type WF, Hz and WP  

Properties Description 
WF/ WP Wave frequency/ Wave period. 
MAmpX Amplitude of force in x-direction. 
MAngX Angle of force in x-direction. 
MAmpY Amplitude of force in y-direction.  
MAngY Angle of force in y-direction. 
MAmpZ Amplitude of force in z-direction.  
MAngZ Angle of force in z-direction. 
RAmpX Amplitude of moment about the x-axis.  
RAngX Angle of moment about the x-axis. 
RAmpY Amplitude of moment about the y-axis.  
RAngY Angle of moment about the y-axis. 
RAmpZ Amplitude of moment about the z-axis.  
RAngZ Angle of moment about the z-axis. 

The input values of the amplitudes (MAmpX, -Y, -Z and RAmpX, -Y, -Z) are positive values. The angles 

(MAngX, -Y, -Z and RAngX, -Y, -Z) will correct for change in signs of amplitude according to the right-hand 

rule. 
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When RAO-table Type Time is chosen, the RAO-table will look like Figure 79. Parameters are elaborated 

in the succeeding table. 

 

Figure 79 RAO-table for type Time 

Properties Description 
Time The time instant for when the load and/or moment is to occur. 
LoadX [N] Magnitude of force in x-direction. 
LoadY [N] Magnitude of force in y-direction. 
LoadZ [N] Magnitude of force in z-direction. 
MomentX [Nm] Magnitude of moment about x-axis. 
MomentY [Nm] Magnitude of moment about y-axis. 
MomentZ [Nm] Magnitude of moment about z-axis. 

 

RAO Type: Drift polar 

Selecting RAO type Drift polar, RAOs are defined in terms of drift-coefficient in polar coordinates.  

 

Figure 80 RAO table for RAO type Drift polar 

Properties Description 
WF/ WP Wave frequency/ Wave period. 
SQRT(Drift coefficient) Magnitude of drift-coefficient (sqrt(T)). 

The direction of the drift-coefficient is regulated by the ‘Add degree’. 

When RAO-table Type Time is chosen, the RAO-table will look like Figure 81. Parameters are elaborated 

in the succeeding table. 
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Figure 81 – RAO table for type Time 

Properties Description 
Time The time instant for when the drift-coefficient is to act. 
SQRT(Drift coefficient) Magnitude of the drift-coefficient (sqrt(T)). 

 

RAO Type: Drift cartesian 

Selecting RAO type Drift cartesian, RAOs are defined in terms of a drift-coefficient in cartesian 

coordinates (x, y, and z). 

 

Figure 82 RAO table for RAO type Drift cartesian 

Properties Description 
WF/ WP Wave frequency/ Wave period. 
MAmpX Magnitude of drift-coefficient (sqrt(T)) in x-direction. 
MAmpY Magnitude of drift-coefficient (sqrt(T)) in y-direction.  
RAmpX Magnitude of drift-coefficient (sqrt(T)) about the x-axis.  
RAmpY Magnitude of drift-coefficient (sqrt(T)) about the y-axis.  
RAmpZ Magnitude of drift-coefficient (sqrt(T)) about the z-axis.  

The input values of MAngX, MAngY, MAmpZ, MAngZ, RAngX, RAngY and RAngZ is inactive because drift 

forces are not included for these directions. The direction of the drift-coefficient is regulated by the ‘Add 

degree’.  
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4.1.4 Impulse loads 
Impulse loads can be used to simulate the 

effect of e.g. collisions or other impulse loads. 

This is a dynamic calculation and will be 

added to the model after the initial steps. To 

get an accurate result, it is important to input 

correct mass and speed; dynamic forces 

acting on the node is a result of accelerations. 

 

 

 

 

4.1.5 Springs 
There are 8 different springs that can be 

added to nodes: Normal, Initial, Dampner, 

Displaced, Buoy, Offloaded, Mass and 

Offloaded type 2. For more information about 

the different springs, see (Berstad A. J., The 

AquaSim package Theory user manual, 2021). 

Buoy and Displaced springs will have an extra 

line of information. Buoy can have a 

maximum force; the spring force cannot 

exceed this upper limit. Displaced have an 

input of meters the spring can move in the 

negative z-value. 

The input will change depending on what kind 

of spring is being added: 

Mass – Mass and Inertia 

Displaced – Stiffness and Damping 

Dampner – Damping translation and damping rotation 

Rest – Stiffness and Stiffness rotation 

  

 

Figure 83 - Properties for impulse load 

Figure 84 - Properties for spring, here represented by a buoy 
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4.1.6 Shapes 

Shape properties 

Name The name of the shape. Visible 
in the node decorators window 
and in AquaView. 

Shape The 3D model file for this shape 
Derived 
from nodes 

Normal rotation only works for 
beam elements, ticking this 
option allows two degrees of 
rotation to be extracted from 
truss and other non-beam 
elements. 

Swap 
direction 

Applies for rotation that are 
derived from nodes (option 
above), tick this if your shape 
rotates in the wrong direction in 
the result. 

Translation Optional offset from the center 
of the model. 

Scale Optional scale of the model. 
Rotation Optional rotation of the model 
Color Optional color of the model. 

Each color (Red, Green, and 
Blue) can be individually set 
between 0 and 1. 1, 1, 1 is 
white. 1, 0, 0 is bright red, etc. 

 

Bind shape to element 

Shapes can additionally be bound to an element. First use the command “Bind shape to element”, see 

Figure 76, then left click on an element attached to the node to bind it. A shape bound to an element 

will follow the rotation of the element. 

If the shape is bound to an element the user must enable Rotation in the result output in the 

Environment dialog. 

Shape active 

AquaEdit automatically adds shapes to pointloads, springs, hinges etc. on export. These default shapes 

can be overridden by checking the box “Shape active” when editing decorators. Then the button “Edit 

shape” will become active and the user can add/edit a shape for the decorator. 

Figure 85 - Properties for shapes 
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4.1.7 Prescribed displacement 
Adding a prescribed displacement will force a 

node to move to the location – or rotate, in 

the initial steps. Input is the absolute 

coordinate (position) or radians (rotation).  

For any position or rotation to be active, they 

must be activated in the check boxes. 

The input for position can be changed to 

relative position to the node by checking the 

box “Relative displacements”. 

 

 

 

 

 

 

 

 

 

  

Figure 86 - Properties for prescribed displacement 
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4.1.8 RAO 
Response Amplitude Operators are used to 

move nodes in the dynamic steps. As 

prescribed displacement one must activate 

which DOF the RAO should apply to using the 

check boxes. 

Fixed translation gives the x-, y- and z-

translation, where prescribed rotation specify 

rotation about the same axes. In the initial 

steps the nodes are prescribed in linear 

increments. Then the end point becomes the 

origin for the RAO motion.  

Position of RAO data defines the origin of the 

RAO data. If (X, Y, Z) = (0m, 0m, 0m) then RAO 

data will have its source in the origin of the 

global coordinate system. 

One must also specify an RAO table. These 

can be added using the dropdown menu and 

selecting “(new)”. All the RAO tables in the 

model are also shown in the dropdown menu. 

The RAO tables can also be edited in the 

menu Tools > Show RAO tables. 

 

 

RAO table 

 

Figure 88 - Properties for RAO table 

  

Figure 87 - Properties for RAO on nodes 
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Properties Description 
Name Name of the table. 
Symmetric Activates symmetry in the RAO tables. If RAO tables are defined for 0-180 

degrees, selecting “Symmetric” checkbox AquaSim will apply equivalent 
tables for 180-360 degrees. 

Angle of 0 direction The angle of 0 direction in the RAO. 
Type Indicator as to the RAO shall be given in terms of Wave frequency (WF), 

Hertz (Hz), Wave period (WP) or Time. 
Indicator of wave angle Indicator as to whether angles is given in radians or degrees. 
Indicator of phase angle Indicator as to phase angles in RAO shall be added or subtracted. 
Indicator of rotations Indicator as to how the operator for rotations is given: 

Radians per unit wave elevation. 
Degrees per unit wave elevation. 
Relative to the steepness of the wave.  

 

Properties Description 
WF/ WP Wave frequency/ Wave period. 
MAmpX Amplitude for motion in x-direction. 
MAngX Angle for motion in x-direction. 
MAmpY Amplitude for motion in y-direction.  
MAngY Angle for motion in y-direction. 
MAmpZ Amplitude for motion in z-direction.  
MAngZ Angle for motion in z-direction. 
RAmpX Amplitude for rotation about the x-axis with reference to wave height.  
RAngX Angle for rotation about the x-axis. 
RAmpY Amplitude for rotation about the y-axis with reference to wave height.  
RAngY Angle for rotation about the y-axis. 
RAmpZ Amplitude for rotation about the z-axis with reference to wave height.  
RAngZ Angle for rotation about the z-axis. 

The input values of the amplitudes (MAmpX, -Y, -Z and RAmpX, -Y, -Z) are positive values. The angles 

(MAngX, -Y, -Z and RAngX, -Y, -Z) will correct for change in signs of amplitude according to the right-hand 

rule. 

If Time is chosen as type, the RAO-amplitudes will operate as a function of time. The amplitudes are 

displacement and rotations, see Figure 89.  

 

Figure 89 - Properties for RAO table, type Time 
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4.1.9 Follow node 
Follow node are used to allow nodes to follow 

the translation and/or the rotation of other 

nodes.  

Activate the checkboxes to allow the node to 

follow the selected node, which can be 

changed by clicking “Select node” and 

selecting a node in the drawing window.  

Pressing the …-buttons will give the user the 

option of selecting a node to follow for that 

DOF, so in theory a node can follow up to 6 

different nodes.  

 
 

 

4.1.10 Roller 

 

Figure 91 - Properties for roller 

A roller will roll along the elements as mentioned in the input. It can roll along the elements attached to 

it all the way to the last elements specified. In Figure 91 the roller can roll along the elements marked in 

red (first element A) and light red (last element A) on the left side of the node, and the elements marked 

in blue (first element B) and light blue (last element B) on the right side of the node.  

Figure 90 - Properties for follow node 
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The elements that the roller can roll over last is set as default the same as the first elements; the 

elements attached to the node. This can be changed by the …-button and has three options:  

- Set same as first element (the default). 

- Set to end of component (the roller can roll along the entire component that the first element 

has as parent. 

- Choose with pointer (click on the element wanted with the mouse pointer, used in Figure 91). 

Minimum length element A / B: 

The minimum lengths give the length the roller can roll towards the end points. E.g., minimum length of 

0.5 will make the roller stop when it is 0.5 meters from the end of the cable (given as last element A and 

B in the dialog). Stepping factor and Decrease stepping are numerical parameters applied when 

AquaSim iterates to find the roller position.  

Tolerance and Delta force: 

When the analysis is run, the axial forces in element A and B are compared and the time step will not 

converge until the forces are within the “Tolerance” of the defined “Delta force”. If “Delta force” is 0, 

the difference in axial force in element A and B need to be lower than the “Tolerance”. 

Delta force: 

Positive values means one element is larger than the other, while negative values mean the opposite 

element is largest. 

Several rollers can be edited at the same time after creation by selecting nodes with roller on them, 

right clicking with the mouse and using Roller > Edit. 

4.1.11  Edit local coordinates 
A node can be assigned a local coordinate system. The x-, y- 

and z-values of the local x-axis and local z-axis are the 

parameters that determines this. 

If the decorators on the node are dependent on the 

orientation and the element the decorator is connected to, a 

local coordinate system on the node is useful. This will enable 

the decorator to change its own axis during the analysis to 

rotate along its connected element. A local coordinate system 

will affect all decorators attached to the node. 

 

 

 

4.1.12  Snap node to terrain 
If the model has an imported terrain, this will make all selected nodes snap to the location of the terrain 

directly below the nodes. 

  

Figure 92 - Properties for local coordinates 
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4.2 Elements 
When one or more elements are selected 

the Object Property Window will display 

the properties of the element(s). 

This show the element length, 

component name that the element 

belongs to, element name, global 

coordinates of the start and end nodes as 

well as the point 3 for the element. 

The panel also shows all decorators 

added to the element. The decorators 

can be edited by clicking the …-button and 

removed by clicking the X-button. 

 

 

Figure 94 - Context menu for elements 

Figure 94 shows the menu when the mouse is right-clicked in the draw window. This menu gives the 

possibility to add new or existing decorator to elements. The same menu, excluding Remove-menu, is 

found in the popup-menu for the element property panel shown in Figure 93 and the menu Commands 

-> Elements. This menu also has the option To active component, this is explained in chapter To 

active component, and the option Selection to elements, that turns selected nodes into selected 

elements. 

 

 

 

Figure 93 – The element property panel 
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4.2.1 Hinge 
A hinge is applied on one end of an element of 

a beam. The hinge will by default be added to 

node B of the element and will be visualized 

by a green cone, see Figure 96. The hinge can 

be added to node A by checking the box 

“Reversed”. 

Check the boxes in the “DOF”-field to lock the 

hinge in one or more of the six Degrees Of 

Freedom of the node. Default is locked in all 

degrees. 

To make the hinges follow the rotation of the 

hinged elements during the analysis, check 

the box “Co-rotated” and here the user can 

define the local coordinate system of the 

hinge. The checkbox “Local” will calculate the 

local coordinate system of the hinge based on 

the position of the nodes of the element. 

It is possible to add a spring to the hinge by 

checking the box “Spring”. Input is almost the same as shown in chapter Springs. The difference is that 

the types of spring allowed is Node2Node and Type14 damper, see chapter Node2Node spring. 

 

Figure 96 - Visualization of hinge on beam element 

Figure 95 - Properties for hinge 
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4.2.2 Winch 
A winch is applied on one end of an element of a beam or a 

truss. The winch will by default be added to node B of the 

element and will be visualized by a green puck, see Figure 98. 

The winch can be added to node A by checking the box 

“Reversed”. 

Type In means that the winch can winch in the entire length 

of the element it is attached to. “Maximum force” is the 

maximum allowed force in the winch. 

Type Out means the winch can winch out elements lying 

behind the element it is attached to, input “Segments” will 

tell AquaSim how many dummy elements it can create for the 

winch. E.G. segments 5 and element length of 10 meters will 

allow the winch to winch out 50 meters. Note: If there are 

several out winches in the model, the one with the highest 

“Segments” will apply to all. 

The winches are winched with the velocity given. Unit is m/s. 

 

Figure 98 - Visualization of winch on beam element 

4.2.3 Linebreak 
It is possible to simulate a break in an 

element during the analysis by adding a 

Linebreak to it, where the only input is the 

step where the break happens. This will 

remove the entire element at that step. 

Figure 97 - Properties for winch 

Figure 99 - Properties for linebreak 
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4.2.4 Valve 
A valve is applied on one end of an element of a beam. The valve will by default be added to node B of 

the element and will be visualized by a green 

puck atop a green disc, see Figure 101. The 

valve will by default be added to node B of 

the selected element. It can be added to node 

A by checking the box “Reversed”.  

For theory on valves and the input 

parameters, read (Berstad A. J., The AquaSim 

package Theory user manual, 2021). 

 

 

 

 

 

 

 

 

 

Figure 101 - Visualization of valve on beam element 

Figure 100 - Properties for valve 
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4.2.5 Point 3 
Point 3 is the point in which trusses and beams will have 

their z-direction orientated, this coupled with the local x-

axis that goes from node A to node B gives the local y-axis 

and the cross-section of beams is orientated after this.  

AquaEdit will automatically calculate this number. For all 

elements, but vertical ones, point 3 will be based on the position of node A and added a large z-value so 

that the point 3 will lie high above the element and thus gives a correct local y-axis. For vertical 

elements this will not suffice and is a bit trickier. So AquaEdit sets point 3 for vertical elements equal to 

0,0,0 for all elements not lying in the global z-axis, then the point 3 is set as 1,0,0.  

The user can edit this in three ways. 

Set point 3 

Edit point 3 manually. 

Set point 3 to center of marked elements 

Sets point 3 to the center of all the currently marked elements. 

Set point 3 to center of component 

Sets point 3 to the center of the parent component on the marked elements. 

If point 3 has been edited, it can also be deleted by using the menu “Delete point 3”, this will return to 

the default that AquaEdit calculates point 3 automatically. 

4.2.6 Flip selected elements 
This will cause the nodes to swap places, node A will move to node B and vice versa. Useful in cases 
where the placement of node A and B is significant, such as for hinge or roller. The user can then flip the 
elements with the wrong node to make up for this. This option is found in Commands > Elements. 

4.2.7 Components 

Hide component 

Hides the parents of the selected elements. 

Select 

Selects the parents of the selected elements. 

Edit 

Brings up the property window for the component. 
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4.2.8 Create Catenary slope 
A Catenary slope allows the user to create catenary 

mooring system. The slope is calculated and 

generated based on the input as illustrated in the 

figure to the left.  

The user must first draw a straight line in XZ- or YZ-

plane (works as a guideline). Select the line Elements 

> Create Catenary slope. For information about 

theory, reference is made to (Berstad A. J., The AquaSim package Theory user manual, 2021). 
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5. Menus 
There are 6 main menus: File, Edit, Commands, Tools, Windows and Help. 

5.1 File 
New 

This will create a new model. If there is an open model with changes 

made, the user will get a question asking to save the model. 

Open 

Opens a dialog where the user can choose which saved model to open.  

Open recent 

This will contain a list of the ten most recent models worked on. This 

list can be cleared by clicking “Clear recent files” under the recent 

models in the list. 

Save 

Saves the model. If the model has not been saved to file before, the 

user will get a dialog asking to choose a file name for the model. 

Save as… 

Allowing the user to save the model to a file name of the users choosing. 

Settings 

Open the settings window, see chapter Settings. 

Model properties 

Opens a window where the user can input and view some properties of the model, see Figure 103. 

Exit 

Closes the application. If there is a model with changes the user will get a question to save the model 

before exiting. 

Figure 102 - File menu 
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Figure 103 - Model properties window 

5.2 Edit 
Undo 

Undoes the last action in the model. 

Redo 

Redoes the last undo. 

Intents 

Same as covered in Functions and intents. 

Delete 

Deletes selected nodes/elements. 

Add new component 

Adds a new component. 

Add new shape 

Adds a new shape component. 

Select all 

Selects all nodes/elements, based on what is already selected in the model. 

Select none 

De-selects all selected nodes/elements. 

Merge file 

Open another model and merges the current model with this. 

Figure 104 - Edit menu 
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Rotate model 

Rotates the entire model clockwise based on input from user, given in degrees. 

5.3 Commands 
Nodes 

See chapter Nodes. 

Elements 

See chapter Elements. 

Components 

Some of the sub-menus are covered in the chapter Components.  

Views 

Mostly covered in chapter 2.5, but this menu gives a few more options to 

view the model from other viewpoints. 

Zoom 

Gives the user some different ways of zooming. E.g. to the largest or smallest 

x-values, to the middle of the model or zoom the model to fit in the current 

view. Keyboard shortcuts are also shown for using these menus fast via 

keyboard. 

Import terrain 

See chapter Import terrain. 

Import image 

Gives the user the option of importing an image file that will lay as a shape component with the center 

of the image in the origin. 

Verify model 

Checks the model for errors and warnings. How much this menu will check and how thorough it will be 

can be edited in Errors and warnings under Settings. 

5.4 Tools 
Scripts 

This shows all the scrips available in the scripts-folder in the AquaSim-folder located usually in My 

Documents. 

Figure 105 - Commands menu 
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Generate net 

Creates an optimized net – just the bottom or the net in its entirety. This 

tool is found in Tools > Generate Net. 

When generating the bottom, the Net generator takes advantage of the 

explicit membrane type to allow for triangles to be generated to 

optimally fill the geometry of a bottom. The net sides are generated 

with the convention membrane component type. See Figure 107 and 

the following table for description of the input to the generator. 

See Figure 109 for an example of a net generated with triangle 

membrane elements included. 

 

Figure 107 - Net generator input 

Properties Description 
Center This marks the center of the net. This is also the upper boundary of the 

net. 
Net radius The radius of the net. 
Net circumference The circumference of the net. 
Net sides 
Height If a straight-sided net is to be generated. This parameter defines the 

height of the sides. 
Segments Number of elements along the net height. See example in Figure 110. 
Net bottom 
Slices The number of “wedges” the net is cut into. Total amount of outside 

nodes is Slices * Slice division. 
 

Figure 106 - Tools menu 
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Slice divisions The number of nodes to split each “wedge” into. 
Note: Amount of tangential lines depend on the Division resolution. 

Depth The depth of the imagined center point of the net. 
Fill bottom Enables filling the bottom of the net using triangles. 
Subdivide radial axis Splits each element into 2 on the tangential axis. 
Bottom radius The net bottom can be generated with an open tip. Applying this, the 

user can define the radius or circumference of this opening. Bottom circumference 
Circular Circularizes the mesh. 
Apothem adjustment Creates a non-circular net with number of sides according to the 

number defined in “Net division”. Example: if Net divisions =8, then an 
octagon will be generated, see Figure 108. 

 

Figure 109 provides an example of appliance of the tool where only bottom is generated. 

 

 

Figure 108 – Example of Apothem adjustment 

 

 

Figure 109 - Example of net bottom generated by the 
generator 

 

Figure 110 provides an example of appliance of the tool with net bottom and sides.  

 

Figure 110 – Straight-sided net generated applying the net generator  



   

94 
AquaSim 2.17 

Generate hex 

Creating a hexagonal net can be done with the Generate Hex. This is found in Tools > Generate 

Hex. 

 

Figure 111 - Generate hex dialog 

Each hex is represented by their knot length, mask height, and mask width. The relationship between 

these are shown in the diagram above. Noted that Mask width is the length equal to the length the 

middle of two masks. 
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Because AquaSim describes geometry with lines with no thread thickness, thread diameter modifies the 

width of knot length and mask width to take into account the thickness of the thread diameter by 

moving the connection points by ½ thread diameter. 

Generating membranes are done by first creating Membrane X elements that will be used for the 

template to generate the hex elements inside. 

The simplest way of generating a net is to use Draw Circle and create the outline of the net, use Extrude 

to generate the height of the net, and convert the component to Membrane, and then to Membrane X. 

Then select all the elements (right click component, operations > select). 

This should yield something akin to the example picture. 
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Bring up the hex membrane window and enter the wanted parameters. 

Axis length should now be calculated from the size of the first membrane element that was selected (it 

is strongly advised that all Membrane X elements are the same size in this procedure). Emit connectors 

enables generating ‘help trusses’ in net hex net. 

The Fit field can be used to set the number of hexes per axis length of the element (Note: a hex is the 

length of mask width, which technically makes two masks. This is done to have the edges of hexes meet 

up when generating nets). 
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After generating the hexes, we should have something similar as the picture above. The nets should 

have created a good fit around the edges. 

Note: For generating a bottom for this, use the Bottom tab and set Fit to same as when generating the 

net, set the radius to the same as when generating the circle for the net, make slices the same amount 

as segments for the circle, and slice divisions to 0. More information on this in the Generating bottom 

segment under. 

After generating, the Membrane X component will still be in the components list. This can either be 

disabled or deleted, it is no longer needed. 

A scale can be entered manually if wished. Scale will be equal to (mask width * 1000 / scale). Generally 

using Fit is advised. 
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Figure 112 - Example of a completed net 

For generating bottoms, the geometry settings are the same as for general hex nets. 

 

A bottom is generated at a center position with a specific radius. These should match the center and 

depth of the start of the bottom, and the radius of the wanted net. 
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In addition, the number of slices and slice divisions can be specified. The example drawing is generated 

with 8 slices (represented by the dark red lines) and each of these slices has been divided into 2. 

Note: In order to get the best fit with circular nets we recommend that the slice 

divisions are set to 0 and extra slices are generated. If slice divisions are used the net 

edges will not match up and will have to be sown together manually at the edges. 

As with the generation of membranes, the bottom also has an axis length (which corresponds with the 

length of a slice, see drawing) which helps in setting the number of hexes generated per slice. 

By entering a number in fit scale will automatically update to be axis length / fit, this will make exactly fit 

number of hexes per slice. The example drawing has specified 3 masks (where a mask is specified by 

mask width). 

A scale can be entered manually if wished. Scale will be equal to (mask width * 1000 / scale). 

Manual drawing or editing Membrane 6 components / elements is possible. To make the component 

use the generate operation as normal. All drawing tools are applicable to the lines for Membrane 6 

elements. The main difference is the “Is vertical” toggle on lines that are classed as vertical. Every 

Membrane 6 “element” must be made up by vertical and “non” vertical lines. Vertical elements are the 

slanted sides, there should be 4 vertical and 2 horizontal for each hex. 

 

Figure 113 - Element property of membrane 6 element 

 

Workspaces 

The user can save the layout and position of all the movable windows, and the saved layouts will be 

shown here. The layout “Default” will always be there, it will reset the windows to the default layout on 

the current monitor. Workspaces can also be deleted from the menu option at the bottom. Note: 

Default cannot be deleted 
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Script console 

Opens the script console. Here the user can open, save, edit and run scripts. 

Show RAO tables 

Shows all the RAO tables in the model. The tables can be double-clicked for editing. 

Show non linear tables 

Shows all the non-linear tables in the model 

Show sloshing tables 

Shows all the sloshing tables in the model. 

Show component contacts 

Shows all the component contacts in the model. 

Copy model 

 

Figure 114 - Copy model window 

This makes it possible to easy copy component properties to the current model from another model, or 

from the current model if several components should have the same properties. 

The current model’s components can be seen on the left, on the right is the source model one can copy 

properties from. As in the component list, components with invalid properties are shown in cursive.  
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Mark one or one and make a copy connection by clicking “Copy”, the copied component lines will 

appear in the window below. Pressing “Copy all” will copy all components with corresponding numbers 

automatically.  

Edit pretension 

 

Figure 115 - Edit pretension window 

This window will show all the trusses in the model. Here it is possible to easy edit the pretension for all 

the trusses at once instead of editing one at a time. 

Show environment settings 

See chapter Export. 

Library 

See chapter Library. 

Decorator library 

See chapter Decorator library. 

Find node 

After exporting, a node cache with node numbers is created. It is possible to search up nodes using node 

numbers after export using this option. 

Run series of batch jobs 

 

Figure 116 - Series of batch jobs window 
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If it is wanted to run several batch jobs after one another, then it can be set up as a series using this 

option. Clicking “Add batch file” will add an existing bat-file to the list and clicking “Create batch” will 

create a master batch-file that runs all the batch jobs in the list after another. Note: Since they are run 

one after another, if one analysis fails then the main batch job will stop and wait for user interaction. 

5.5 Windows 
This will show the tool windows that are currently shown and not shown. 

Clicking on one of the items in the list will show/hide the corresponding tool 

window. 

 

 

 

 

 

 

 

 

 

5.6 Help 
Welcome 

Will show the welcome window and change log. 

User manual 

Opens this user manual in a pdf viewer, if installed. 

Documentation center 

Opens the online Documentation center for AquaSim. Tutorials, papers and 

reports available for the user. 

Theory manual 

Opens the theory manual, (Berstad A. J., The AquaSim package Theory user manual, 2021), in a pdf 

viewer, if installed. 

Generate error report 

The user can send an error report by mail to the support team by using this option. Write in the issue, 

email-address and optionally add files to be included in the mail. 

Check for update 

Checks if there is an update to the AquaSim package available. 

Figure 117 - Windows menu 

Figure 118 - Help menu 



   

103 
AquaSim 2.17 

Check for updated solver 

Checks if there is a new solver available for downloading. 

About 

Shows information about AquaEdit. And gives the option to view and enter a new license key.  
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6. Library 

 

Figure 119 - The library window 

The library window will show the content of the library folder, which can be edited in Settings > 

General. The installation of AquaSim will by default install an empty folder named library in My 

Documents/AquaSim, if this folder already exists then nothing will happen. This default folder contains 

four sub-folders; beam, materials, membrane and truss. 

The left tree shows the folders and sub-folders. If the selected folder contains any library files, then 

these will be shown in the middle list. The right list shows some properties from the selected file in the 

middle list. 

It is possible to drag & drop items to and from the middle list. It is possible to drag directly to the 

component list and to the windows explorer. It is also possible to drag from Windows Explorer and into 

the middle list. 

New category 

Will create a new sub-folder under the folder selected in the left tree. 
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Add folder 

Will add a selected folder from the computer in the left tree. 

Open in explorer 

Will open the selected folder in Windows Explorer. 

Delete 

Will delete the last selected item. If the last selected item is a library file from the middle, then only this 

file is removed. If the last selected item is a folder from the left tree, then this folder and all files in the 

folder will be deleted. Root folders cannot be deleted. 

New 

Will create a new library file. If one of the four default folders or their sub-folders are selected, then a 

new preset of that type will be created. If the root folder is another then the user will be asked what 

kind of library file to be created; beam, truss, membrane or material. 

Copy 

Will make a copy of the selected library item into a new name selected by the user. It is possible to edit 

the properties of the copied item before saving. 

Edit 

Edits the selected library item. 

 

If the library is opened from the component list by right-clicking on an item and selecting “Library”, then 

the options are “Export” and “Apply”. There are no drag & drop options here. 

“Export” will export the selected component properties into the library, in the chosen folder. 

“Apply” will apply properties to the component from the selected library item. 
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7. Decorator library 

 

Figure 120 - The decorator library 

The decorator library window will show the content of the decorator library folder, which is a folder 

within the library folder named “decorators”. The installation of AquaSim will by default install empty 

folders with all the decorators having its own folder; hinge, impulseload, linebreak, pointload, 

presctibeddisplacement, raonodedecorator, roller, shapedecorator, spring, valve, winch. 

The left tree shows all folders and sub-folders. If the selected folder contains any library files, then these 

will be shown in the middle list as shown in Figure 120. The right list shows some properties from the 

selected library file. 

New folder 

Will create a new sub-folder under the folder selected in the left tree. 

Add folder 

Will add a selected folder from the computer in the left tree. 

Open in explorer 

Will open the selected folder in Windows Explorer. 
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Delete 

Will delete the last selected item. If the last selected item is a library file from the middle list, then only 

this file is removed. If the last selected item is a folder from the left tree, then this folder and all files in 

the folder will be deleted. Root folder cannot be deleted. 

New 

Will create a new library file.  

Copy 

Will make a copy of the selected library file into a new name selected by the user. 

Edit 

Edits the selected library file. 

 

If the decorator library is opened from the Decorators list by right-clicking on an item and selected 

“Library”, then the options are “Export” and “Apply”. 

“Export” will export the selected decorator into the library, in the chosen folder. 

“Apply” will apply properties to the decorator from the selected library item.  
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8. Settings 
8.1 General 

 

Figure 121 - General tab 

Enable combability mode 

This is an optional setting for some older/incompatible graphics card (esp. older Intel integrated cards). 

If the screen is black, try enabling this and restart AquaEdit. 

Enable legacy drawing mode 

The default render engine used in AquaEdit is based on shaders. Older graphic cards and some 

integrated graphic cards from Intel may not be powerful enough to leverage this render mode. Toggle 

this to go back to the old render mode. Restart AquaEdit to apply this change. 

Backup on save 

When enabled, a copy of any overwritten file will be made. Should something prevent the new model 

from saving then you will be able to find a backup of the last save file named something like: “mymodel-

2018-01-15-12-39-06.bak” in your model folder. 

Enable point 3 

This will let AquaEdit handle point 3 information. It is recommended to keep this on. 

Automatically import XML data on text import 

When this is enabled, importing an AquaSim text file automatically import the companion XML file. 
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AquaSim version 

Specifies which AquaSim executable should be used when exporting and running an analysis. 

Node panel GPS type 

In the properties for nodes, a GPS property will be shown if a terrain or olex plot has been imported. 

How the GPS value is shown can be edited by this. The values are DD, DM, DMS & UTM. 

Auto save 

If this is set higher than 0 AquaEdit will attempt to save the model every x minutes into a separate file, 

named “mymodel.amodel.autosave”. If something goes wrong, then it is easy to load the autosave file 

and not lose any data. 

Folders 

The paths to the different folders used by AquaEdit. 

8.2 Scripts 
Not currently in use. 
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8.3 Drawing 

 

Figure 122 - Drawing tab 
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Snap and thresholds 

“Automatic snap threshold” is the minimum distance that AquaEdit will allow. Anything drawn closer 

than this value to another node will automatically snap to that node.  

“Merge tolerance” is the threshold used in Merge lines. If the angle between two elements being 

merged is larger than this threshold then the lines will not be merged together. 

“Turn off snap….” will set node snapping to off if enabled, this will come in affect when opening a model 

or creating a new model. 

Mouse acceleration 

These specify how fast AquaEdit should respond to different mouse inputs. The “Alternate zoom” will be 

used when SHIFT is held down when zooming with the mouse wheel. By default, this zooms faster. Use 

a smaller value than the normal zoom value if the wanted zoom speed should be lower than the normal 

zoom. To alternate the zoom, negative values can be typed in “Zoom”. 

Mouse input 

“Zoom to cursor” enables to always zoom towards the location of the mouse pointer. If this is disabled, 

then the zooming will be towards the middle of the screen. 

“Rotate around the origin” will make the mouse rotate around the point 0,0,0. If disabled, the mouse 

will rotate around the current pointer location, or the selected nodes/elements in the model if selection 

is non-empty. 

“Use relative view rotation” will maintain the centered camera view of the model when applying 

hotkeys Arrow UP/DOWN/LEFT/RIGHT, HOME, END, PgUp/PgDwn. 

“Automatically snap to locations” toggle on means that the preview of Move and Draw line will at a 

certain distance snap to the nearest node. 

Membrane generation 

Enabling this will discard membrane elements with its area smaller than the input here. This avoids 

some degenerated membrane elements from being generated. 

Default shapes 

When adding some decorators, a default shape will be added to the visual model. These can be scaled 

using the slider. One can also choose which of the default shapes will be visible by using the checkboxes. 

Individual scaling of size of Hinge shape and the global axis system is also available. 

Node and line size 

Specifies the visual sizes of nodes and elements. 

Drawing space 

Sets the colors of the drawing canvas. 

Grid 

“Grid spacing” is the space between each grid square. Input of 1.0 here means the grid squares is 1x1 

meters. 
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“Grid extent” is the extent of the grid in x- and y-direction from the origin. Input of 50 here will give a 

grid size of 100x100 meters.  
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8.4 Errors and warnings 

 

Figure 123 - Errors and warnings tab 

When running Verify model there are some checks that might be unwanted. 

Short elements 

This enables the detection of elements that are shorter than the minimum length. 

Equal elements 

Elements that are equal are elements going to/from the same nodes. Enabling this will give an error if 

there are any equal elements on the same component. 

Enabling “Between components” will give a warning if there are equal elements that does not belong to 

the same component. 

Overlapping elements 

Overlapping elements are elements going to/from one equal node and one element overlapping the 

other. E.g. one element being <0,0,0> -> <1,0,0> and the other being <0,0,0> -> <2,0,0>. Enabling this 

will give an error if there are any overlapping elements on the same component. 

Enabling “Give warning” will give a warning instead of an error for the problem of overlapping elements 

on the same component. 

Enabling “Between components” will give a warning if there are overlapping elements that does not 

belong to the same component. 
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Close nodes 

Checks to see if nodes are closer together than the minimum distance (usually indicates they should 

have been merged). 

Empty components 

Allow components that have no elements in them.  

Loose nodes 

Enabling this will give a warning if there are nodes with only one element attached to them. If the node 

has checked off DOF for translation on all three axes, then this will give no warning. 

Loose elements 

Enabling this will give an error if there are elements that are not connected to any other elements and 

both nodes are loose. 

If there is a component that has invalid properties (e.g. negative e-modulus on a beam) then Verify 

model will produce an error, this cannot be turned off since an invalid component will cause the analysis 

to crash. 

Allow membrane generator to make broken elements 

Enables membrane elements that has an aspect ratio close to a triangle to be accepted and allowed. 

Having this option deselected, AquaEdit will not allow panels of component type Membrane that 

resembles too much of a triangle to be included in the analysis. 

8.4.1 Fix / Fix problem type 
Having detected findings according to specifications in the “Errors and warnings”-tab, AquaEdit provides 

solution proposals to correct, or fix, the model. Choosing Fix will solve the isolated problem, and Fix 

problem type will solve all problems within the same problem-category. To view and highlight the 

problem area in the model, the user may select the Zoom to problem-button. Description of actions 

AquaEdit do upon selecting Fix or Zoom to problem for the different errors and warnings, is provided in 

the table below. 

Verify actions Description 
Short elements, 
Warning: 

Fix: cannot fix. The user must either adjust the length of the element, or 
the reduce value defined in “Errors and warnings”-tab. 
Zoom to problem: select and zooms to the short element. 

Equal elements Fix: deletes all but one of the equal elements. 
Zoom to problem: zooms to the element and selects the element that 
will remain after fixing the problem. 

Overlapping elements Fix: deletes all but one of the overlapping elements. 
Zoom to problem: selects the element that will remain after fixing the 
problem. 

Close nodes Fix: merges the two nodes. 
Zoom to problem: zooms to the problem node, selects both nodes. 

Empty components Fix: deletes the component without drawn elements. 
Zoom to problem: cannot zoom, since there are no drawn elements. 

Loose nodes Fix: sets the DOF to limit translation/rotation. 
Zoom to problem: zooms to the node, selects the node. 

Loose elements Fix: sets DOF on node A of the element to limit translation/rotation. 
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Zoom to problem: zooms to the element and selects the element. 
Broken elements Description: broken elements are elements that have duplicate nodes. 

Usually caused by improper merging or automatically generated models. 
Fix: deletes the broken elements. 
Zoom to problem: selects the broken element and zooms to it. 

Node/element decorator Description: error has been found in a node or element with a decorator. 
Fix: deletes the decorator. 
Zoom to problem: zooms to the element/node with the problem-
decorator in question. 

Invalid component 
properties 

Description: an error has been found in the properties of a component. 
Usually due to missing input or improper values. 
Fix: opens the editor for the component. 
Zoom to problem: cannot zoom. 

Point 3 on line Description: point 3 coincides with the element length-axis. 
Fix: resets point 3 back to default values. 
Zoom to problem: selects and zooms to the element in question. 

Roller tolerance Description: roller tolerance must be 0.1 or higher. 
Fix: cannot fix. The user must correct the values in the roller properties-
window. 
Zoom to problem: zooms to the node with the invalid properties, opens 
the roller properties-window. 

Hinge cannot exist on 
non-beam elements 

Description: a hinge is only supported on beam elements. 
Zoom to problem: selects the problem-element and plate the camera 
looking at the element. 
Fix: deletes the invalid hinge from the element. 
Fix problem type: deletes all invalid hinges from elements they are 
attached to. 

Membrane too 
triangular, consider using 
triangular membrane x 
triangle elements 

Description: the quad element (i.e., a 4-noded membraneX) resembles a 
triangle too much.  
Fix: the user must convert the quad element to a triangle element.  
Zoom to problem: centers the 3D view to the node that is in-line with the 
two other nodes in the quad element.  
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8.5 GUI and Workspace 

 

Figure 124 - GUI and Workspace tab 

Properties Description 
View on startup Sets a default view of the 3D model upon loading AquaEdit. Choose between 

Isometric, Front-, Top-, Left-, Right-, Back- and Bottom View. 
Zoom to fit on start Zooms in or out so you can see the entire model upon start of AquaEdit. 
Fullscreen on startup Selection for always load AquaEdit in fullscreen mode. 
Starting distance Sets a default distance to the model upon loading AquaEdit. Unit in meters. 
Workspace All saved workspaces are shown here, as well as Workspaces. 

- Add new: saves the current workspace layout.  
- Delete: deletes a highlighted workspace from the list. 
- Reset: sets the saved workspace back to default. Only “Default” will 

be shown. 
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8.6 Hotkeys 

 

Figure 125 - Hotkeys tab 

There are several functions in AquaEdit that can be used with hotkeys on the keyboard. All the hotkeys 

are stored and shown here. These can be reset to default by clicking the “Reset to default” button. The 

hotkeys can also be edited by clicking on a hotkey in the list and then clicking the “Edit hotkey” button. 
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8.7 Advanced 

 

Figure 126 - Advanced tab 

Advanced settings show all settings that are set in AquaEdit and allows adding and removing settings. 

In some cases, you may be sent advanced 

settings by Aquastructures support 

employees to fix or alter AquaEdit behavior. 

These settings are added by selecting “Add” 

and filling in the custom setting dialog. 

All settings can be reset to default by clicking 

the “Reset” button. 

 

 

 

 

  

Figure 127 - Add custom setting 
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9. Export 

 

Figure 128 - Export window 

There are two different environment loads that can be added. A set of vectors (Normal) or calculated 

based on a direction (Directional). By default, there are two tabs in the export window named Normal 

and Directional. The user can add more tabs by clicking the “+” button on top, this gives the option of 

adding another tab and will be given a name and a type. To remove a tab, click the “x” button on the tab 

on top.  

Right click on a tab will give the option to rename a tab, duplicate the tab into a new one, close the tab 

or close all other tabs. 

To add a row of environment load to the list, click the “Add” button or Enter key on the keyboard while 

the last row is selected. Clicking “Delete” will delete an environment load from the list. 

Normal (directions are based on the global coordinate system): 

Properties Description 
Nr Order of load condition. 
Amp Wave amplitude (0.95 * significant wave height) in meters. 
T Wave period in seconds. Note: For irregular sea state, T correspond to the zero-

crossing period. 
V Wave direction from global positive x-direction, counter clockwise in degrees. 
cX Current speed in global x-direction in meters per second. 
cY Current speed in global y-direction in meters per second. 
wX Wind speed in global x-direction in meters per second at 10 meters height. 
wY Wind speed in global y-direction in meters per second at 10 meters height. 



   

120 
AquaSim 2.17 

Comment Description of load condition. 
Group Grouping of load conditions when running several simultaneously analyses. 

 

Directional: 

Properties Description 
Nr Order of load condition 
SysH Heading of the system from north to global x-axis, clockwise, in degrees. 
Hs Significant wave height (Amp / 0.95) in meters 
T Wave period in seconds. Note: For irregular sea state, T correspond to the zero-

crossing period. 
WaveH Wave heading (from). Note: Wind heading is the same as wave heading, in degrees. 
Vc Current speed in meters per second 
CurrDir Current direction (towards) in degrees. 
U10 Wind speed (at altitude 10 meters) in meters per second. 
Comment Description of load condition 
Group Grouping of load conditions when running several simultaneously analyses. 

 

Values in the tables can be imported/exported by using Ctrl+c / Ctrl+v when working inside the table. 

Note: Only the selected rows will be exported to the clipboard using Ctrl+c.  

Create max out file 

Generate a max-file from multiple environment data.  

Export groups 

Do several simultaneously analyses. Each process of AquaSim uses one thread on the processor, so by 

using more threads at the same time can reduce analysis time significantly. Grouping is done by using 

group numbers or by using “Automatic grouping” with the number of simultaneously analyses as input. 

Automatic grouping 

Automatic groups the analyses that is run. This is an alternative to manually group the analyses. The 

number of groups to be generated is typed in the field to the right of “Automatic grouping”. 

Delete AVS files after run 

Automatically delete AVS result files after the analysis is finished.  

Analyze immediately after export 

Will open the window shown in Figure 129 when exporting, if grouping is disabled. This shows all the 

analyses that can be run. Clicking on “Start” will start the analysis, and you can start as many or few as 

you want. When one analysis is done, it will jump to the next not-started analysis in the list and start 

that.  

“Show messages” opens another window that shows the output coming from the AquaSim analysis.  

When an analysis is done the button “Open” will become available and this will open the finished 

analysis in AquaView. “Cancel” will stop the running analysis.  
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The label on the left will show the status of the analysis. Dark grey means it has not started. Green 

shows when running and everything is running okay. Yellow means a step has not converged. Red 

means an error has occurred during the analysis or the analysis has been cancelled. 

 

Figure 129 - Analyse window 

“Open folder” will open the folder where the analyses files are in Windows Explorer. 

After an analysis is done the “Create max out” button will be enabled and will create a max-file on the 

finished analyses. 

Enable low priority processes 

Starts the analyses using IDLE priority class. This means that the running analyses will lose processor 

time if a higher priority class needs processor time. More information on the different priority classes 

can be read about here: https://technet.microsoft.com/en-us/library/cc940378.aspx  

Omit PFAT files from the analysis 

Will tell AquaSim to not write out PFAT result files. 

Verify model before exporting 

Will run Verify model to check for any problems before exporting. 

Split file by timesteps 

Will split the result file into several files using ppfilter. 

Extract timestep range 

Will extract a range of steps from the main analysis using ppfilter. 

https://technet.microsoft.com/en-us/library/cc940378.aspx
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Solver version and solver check 

Different solver versions may be selected from the dropdown menu. If the latest solver version is not 

selected, a warning symbol appear; “Not using the latest solver”. The user may check for updated in 

Help > Check for updated solver. 

9.1 Edit 

 

Figure 130 - Edit environment load 

Clicking the “Edit” button when an environment load is chosen, will open the window shown in Figure 

130. The same values can be edited here as in the table itself. Here it is also possible to add/edit varying 

current, time dependent current and irregular sea. 
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9.1.1 Varying current 

 

Figure 131 - Varying current 

To activate varying current, go into the “Varying current” tab and enable the “Active” box. Rows can be 

added and removed by using the “Add” and “Delete” buttons. 

Each row in the table has a depth, current velocity in x-direction and y-direction for type Normal. 

Each row in the table has a depth, current speed and direction for type Directional.  

When a load condition has varying current the current cells in the environment table will be marked in 

grey. 
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9.1.2 Time dependent current 

 

Figure 132 - Time dependent current 

To activate time dependent current, go into the “Time dependent current” tab and enable the “Active” 

box. Rows can be added and removed by using the “Add” and “Delete” buttons. 

Each row has a Time (in seconds) and Factor. This will add the factor with the current at the set time. 

This will only work during the dynamic steps of the analysis, during the static steps it will be the same as 

before. 
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9.1.3 Irregular sea 
To generate irregular sea there are a couple options. You can choose “Irregular” from the “Wave type” 

dropdown list and make a table of waves self or generate automatically using a spectrum. To generate 

from a spectrum, click “Generate” when type is “Irregular” or choose spectrum from the “Wave type” 

dropdown list. There are PM spectrum, Jonswap spectrum and ITTC spectrum.  

For a better understanding of the irregular spectrums, read (Berstad A. J., Irregular wave calculation and 

validation, 2013).  

 

Figure 133 - Generate waves window 

Figure 133 shows the windows that will appear when the user wants to generate waves automatically.  
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It is possible to find “Seed” automatically by clicking the “Target max surface elevation/Hmax”.  

Equation 3 in (Berstad A. J., Irregular wave calculation and validation, 2013) gives the wave elevation 

based on N number of wave components.  

“Max surface elevation” will start at seed = 1, generate 

waves and find the wave elevation. If the wave 

elevation is in acceptance of the target and accepted 

deviance, then we have our seed. If the wanted target 

should come further out in the time series, then “Step 

to start on” will tell the algorithm to start at that step 

and try to find a seed number that gives the accepted 

wave elevation after that step. 

“Hmax” will by default set “Target” to 1.9 * Amplitude 

and start at seed = 1, generate waves and find the difference between the top and bottom of the graph 

generated and see if this difference is within the wanted target. 

E.G. we want to find Hmax after 0 steps, with target 1.9m and accepted deviance at 1%. The main wave 

can be seen on Figure 130, total steps is 1000. This will search for a seed that gives Hmax higher than 

1.881 and lower than 1.92, which in this case is 12.  

“Add waves” will add the number of waves to the wave table, “Replace waves” will remove the old 

waves and add the new created ones. After waves have been added to the wave table it is possible to 

click in the “Plot” button and see the wave height as a function of time, see Figure 134. 
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Figure 134 - Wave elevation over time 

Using our example from above it is easy to see that the highest top is 0.876 and the bottom before is -

1.036, which gives Hmax of 1.911 which is within our accepted deviance. 

It is important to use the plot function to verify if the seed generates the wanted wave elevation/Hmax, 

and that there is no wave elevation/Hmax higher than the accepted deviance further along the timeline. 

If for instance we would have found a Hmax of 1.91 at step 25 and a Hmax of 2.1 at step 51, then we go 

back and find a new seed, and set the step to start on at 52. And repeat this procedure until we are 

satisfied with the result. 

When a load has irregular sea the wave cells in the environment table will be marked in grey. 

It is also possible to plot the spectral values over period with using the “Plot specter button”. Using the 

same irregular sea as before we get the result as seen in Figure 135. 
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Figure 135 - Spectral value over periode 

It is also possible to view the standard deviation of the spectrum with the “σ”-button. In the example 

used above we get a standard deviation of 0.25. 
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9.1.4 Irregular wind 
To generate irregular wind there are currently two options. You can choose “Irregular” from the “Wind 

type” dropdown list or choose NORSOK from the dropdown list to generate irregular wind 

automatically. 

 

Figure 136 - Generate wind window 

Figure 136 shows the window that will appear when the user wants to generate winds automatically. 

For a better understanding of the NORSOK spectrum, see (Berstad A. , Spectral wind loads in AquaSim, 

2019).  

Plotting and viewing standard deviation is the same as it is for irregular sea.  
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9.2 Import 
Clicking the “Import” button will import environment loads from a selected model. Models made before 

version 2.13 will add all loads from that model, with the same type as the current selected tab. Models 

made after 2.13 with customized tabs will open an import window, see Figure 137. 

 

Figure 137 - Import window 

Here, all the tabs from the selected model will be shown. Tabs can be selected to import loads from, and 

it is possible to check off only the loads wanted too.  

“Import this tab” will import the current tab. 

“Import selected tabs” will import all the selected tabs. 

“Import all tabs” will import all tabs. 

“Add new tabs….” enabled will add the imported tabs as new tabs into the export window. This disabled 

will import the loads into the current tab in the export window. Note: It is not possible to import loads 

of type Normal into a tab that supports tab Directional, and vice versa. 
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9.3 Generate irregular sea 
It is possible to generate irregular sea for several load conditions at the same time using this option. 

 

Figure 138 - Generate several irregular seas 

This will open the window shown in Figure 138 with a table with the selected loads in a table sharing the 

same input for generating irregular sea. The table can be edited manually, and waves can be generated 

by entering in a seed for the loads in the table and using “Add waves” or “Replace waves”. It is also 

possible to find the seed automatically for all loads at the same time using “Target max surface 

elevation/Hmax”. The target is in a separate column in the table and all loads will target the same 

Accepted deviance and start at the same step.  

If we use the example above, we will find the seed for the load as shown in Figure 139. 
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Figure 139 - Seeds found 

Clicking OK will add the seeds to the table, and we can use these to add or replace irregular waves for all 

the load conditions.   
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9.4 Time series 
Properties Description 
Time series  
Preincrement Number of initial steps where the model obtains equilibrium 

and current and wind are applied. 
Max iterations per step Maximum iterations before moving to the next step. 
Num total steps for waves Total steps for the waves 
Num steps for one wave Number of steps per wave. 40 total steps and 20 steps per 

wave analyse two wave periods 
Convergence criteria The convergence limit before moving to the next step. The 

lower this is, the more correct the results will be. 
Change dynamic convergence criteria Larger than 0 if convergence criteria shall be changed 

between the static steps and the dynamic steps. 10 means 
the convergence limit is 10 times larger for the dynamic 
steps, 0.1 means the convergence limit is 10 times stricter 
for the dynamic steps. 

Current reduction type No reduction: Current reduction for nets succeeding other 
nets are not accounted for. 
From initial shape: Current reduction from succeeding nets 
are accounted for according to formulae from (Løland, 
1991). The reduction factor is found in the initial 
configuration and kept during the analysis. 
Deformed by current: Current reduction from succeeding 
nets are accounted for according to formulae from (Løland, 
1991). The reduction factor is found in the initial 
configuration and updated for the deformed configuration 
as current is put on.  
Deformed by current and waves: Same as deformed by 
current, but the current reduction factor is updated at each 
wave step. 

Infinite depth This enabled will apply linear Airy wave theory, see (Berstad 
A. J., The AquaSim package Theory user manual, 2021). 

Depth (wave profile) If “Infinite depth” is disabled, this is depth of the velocity 
field below a wave. 

Cresting wave factor Enable non-linear wave profile, see (Berstad A. J., The 
AquaSim package Theory user manual, 2021). 

Bottom  
Bottom contact Simulation of ocean floor by adding spring stiffness (“Bottom 

parameter”) to nodes moving beneath “Bottom depth”. 
If there is an imported terrain then this will be used to check 
for distance between nodes and bottom floor, instead of 
“Bottom depth”. 

Bottom depth Depth to ocean floor, in meters (< 0). 
Bottom parameter Define the spring on the bottom, needs to be higher than 0. 

Higher the value, softer the spring becomes. Meaning larger 
possibility for convergence. 

Bottom friction Friction coefficient between elements and ocean floor. 
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Advanced  
Water volume correction None: Run without any water volume correction for 

hydrodynamic elements. 
Normal: Gives a maximal buoyancy and turns off water 
plane stiffness when a hydrodynamic element is submerged 
and the total of submerged volume of the element is equal 
to the component buoyancy.  
With slamming: Removes buoyancy, drag and added mass 
when elements move out of water. Also calculates slamming 
forces from waves. All input for Morrison elements should 
be as out of water. 

Reported steps How many steps should be reported to the avz-files. 1 is 
every step, 2 is every second step etc. If 0 then AquaSim 
decides how many steps are reported based on number of 
elements and steps. Note: Every step is always reported to 
the PFAT files. 

Convergence accelerator Parameter where one may slack on demands for the 
dynamic damping. 

Newmark damping Parameter in the Newmark beta distribution. 0.5 means 
constant average acceleration. 

Analysis type Static: Static analysis. 
Normal: Static analysis during initial steps, dynamic analysis 
when waves kick in. 
Dynamic: Dynamic analysis from step 1. 

Type of mass Lumped mass: Use lumped mass for beams and trusses. 
Consistent mass: Consistent mass formulation for beams 
and trusses. 
Consistent mass on beams: Consistent mass formulation for 
beams, lumped mass on trusses. 

Buckling/eigen period analysis See chapter 9.4.1. 
Non linear density field See chapter 9.4.2. 
Number of threads Defines the number of threads AquaSim will use per 

analysis. 
Hydrodynamic properties  
Wave headings Results are interpolated between the wave headings 

analyzed. 
Segments on hull Discretization along the hull. 
Segments on water surface Discretization along the surface before matched with far 

field condition. 
Results What kind of results should be written to the result files. 
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9.4.1 Buckling/eigen period analysis 

 

Figure 140 - Bucking/eigen period analysis window 

It is possible to run an own buckling/eigen period analysis of the model. This is activated by the 

“Buckling/eigen period analysis” under Advanced for the time series. To edit the analysis run, click the 

…-button and the window shown in Figure 140 will show. 

Analysis type 

Buckling, eigen periods (excluding mass of truss elements), eigen periods (including mass of truss 

elements) and eigen periods (excluding mass of truss elements and mass caused by node loads). 

Amount of eigenvalues written to file 

Must be higher than 0 and lower than 7. 

Positive eigenvalues closest to 0 to omit 

How many positive eigenvalues closest to 0 that shall be omitted in the eigenvalues written to file. 

Amplitude of the eigen vectors 

The amplitude the eigen vectors are multiplied with in the results. Makes it easier to evaluate results.  

Shift value 

Value where found eigenvalues are centered around. 

Stress value 

Target stress value. Currently not used, but all stress values are reported. 

Analysis valid for 

Eigenvalue analysis valid for linear material relation (nonlinear motions and rotations are ok) and 

general, but noisier buckling response. 

Buckling analysis solves the equation 

𝐾𝑒𝑙𝑒𝑚 −  𝛿𝐾𝑔𝑒𝑜𝑚 = 0 

𝐾𝑒𝑙𝑒𝑚 is the material stiffness for the structural configuration at the timestep. 

𝐾𝑔𝑒𝑜𝑚 is the geometrical stiffness for the structural configuration at the timestep. 
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The result found is the eigenvalue, λ, which is the factor the load distributions should linearly be 

increased to obtain linearized buckling. The corresponding eigenvector is the buckling shape for this. 

Eigen period analysis solves the equation 

𝐾 − 𝜔2𝑀 = 0 

K is the stiffness for the structural configuration at the timestep. 

M is the mass of the structural configuration at the timestep. 

The result found is the eigenvalue, λ = ω2, which is the eigen frequency and T = 2π/ω is the eigen period. 

9.4.2 Non linear density field 

 

Figure 141 - Non linear density field window 

It is possible to change the density of fluid outside membrane elements. This applies for these load 

formulations; General impermeable net, Lice skirt, Closed compartment. This is activated by the “Non 

linear density field” under Advanced for the time series. To edit the density, click the …-button and the 

window as shown in Figure 141 appear.  

One may add or delete input-rows. Values between input-rows are interpolated. The table in Figure 141 

will for instance give a density of 1045kg/m3 at 15 meters depth. Values above the highest depth and 

below the lowest depth will be constant. In this example, the density at depth 0-5 meters is 1010 kg/m3 

and depth below 20 meters is 1060 kg/m3. 

9.5 Export to file 
Clicking the “Export” button in Figure 128 will trigger an analysis. First a file name is chosen and files for 

the AquaSim engine is created. If “Analyse immediately after export” is enabled, then the analysis will 

start immediately. If grouping is enabled the corresponding bat-files are started in the cmd-window in 

Windows.   
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10. Import terrain  
Importing terrain is done from Commands > 

Import terrain.  

10.1.1 Center location 
For AquaEdit to be able to use the terrain 

data it needs to map the origin of the model 

to a known GPS coordinate in the terrain 

data. 

Input type 

Selects the type of GPS coordinates. 

Supported types are Decimal (DD), Hour 

Minute (DM), Hour Minute Second (DMS) 

and UTM.  

When UTM is selected the field “Zone” will 

be active and this must have an input for 

the UTM coordinates to make sense. 

Longitude and latitude 

The longitude and latitude coordinates that 

will be mapped to the origin. 

Heading 

If the terrain should be rotated, input here 

in degrees. This can be edited after import is 

done as well. 

North axis 

Tells where the maps north axis is pointing 

towards, by default this is along the positive 

x-axis. 

10.1.2 Projection 

Projection 

Two types of projections can be used; 

WGS84 and UTM. The UTM projection is 

recommended to only be used along with 

input type of UTM coordinates. 

Datum 

The only datum currently supported is GRS80. 

Figure 142 - Import terrain window 
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10.1.3 Map size 

Length and width 

The size of the imported terrain in meters. 

Tree depth 

The terrain data will be split into rectangles and further subdivided to add detail. The higher the tree 

depth the more subdivisions will be made. The number of subdivisions will depend in the detail of the 

map data. Very low resolution may need to be tweaked down to 6-8, very high-resolution data can go 

up 20. If the data is not of adequate resolution, there will be gaps in the terrain model. 

Maximum interval 

Maximum interval is the maximum slope that is allowed in the model. If the model is very jagged and of 

high density this can go all the way down to 0.5-1. If the data is of poor quality, especially with very high 

height differences this value might have to be tweaked up towards 20-50, but usually this means the 

data is too poor for a good result. 

10.1.4 Olex plots 
It is possible to import geometry exported from Olex as well as a terrain here. Under “Additional 

datasets” it is possible to add Olex geometry files that will be read. The geometry within these files will 

be added as nodes and elements to the model. In order for the terrain importer to understand that a 

Olex geometry is imported, rather than Olex terrain, the user must specify this in the File type drop 

down field at the bottom of the “Open files” dialog. 

 

Figure 143 Selecting the correct file type for importing olex geometry 
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Snap distance 

How close nodes can be before they snap together. 

Maximum import distance 

Points that are further away from the center than this distance will not be imported.  

10.1.5 Default datasets 
If AquaEdit detects known datasets in the shapes\map folder these will be available to include here. To 

use data from Statens Kartverk the file names in the shapes\map folder must be named after the 

abbreviation of the county. For instance, Nord-Trøndelag must be named “NT.txt” for it to be found. 

Here are the abbreviations of the counties in Norway: 

Østfold: ØF 

Akershus: AK 

Oslo: OS 

Hedmark: HE 

Oppland: OP 

Buskerud: BU 

Vestfold: VF 

Telemark: TE 

Agder: AGD 

Aust-Agder: AA 

Vest-Agder: VA 

Rogaland: RO 

Hordaland: HO 

Sogn og Fjordane: SF 

Møre og Romsdal: MR 

Trøndelag: TRL 

Sør-Trøndelag: ST 

Nord-Trøndelag: NT 

Nordland: NO 

Troms: TR 

Finmark: FI 
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To use SRTM data one must download these data and put them in the respected folders named “hgt1” 

and hgt3” in the shapes\map folder. The link to download this is 

http://viewfinderpanoramas.org/dem3.html and one can use the interactive maps on this site to 

download data for 1” and 3”. This is downloaded as a .zip-file and the user must unzip these and copy 

the files into the folders. It is not recommended to include both 1” and 3” data at the same time. 

10.1.6 Other options 

Include texture 

This will download google earth satellite data for the area and apply that to the terrain. Not available at 

the current moment. 

Height offset 

Applies the given offset to the Z axis of the imported terrain, effectively raising or lowering the terrain. 

10.1.7 Additional datasets 
Other data sources can be added by clicking the “Add” button, all other datasets will be shown here. 

Supported sources are Olex files, generic txt-files, STRM data, XYZ files and OBJ 3D-models.  

11. TPE file format 
In order to facilitate easy import og geometry generated or otherwise obtained from other programs, 

scripts, or manual modelling, AquaEdit can also import a file format called .TPE or Point-To-Point files. 

These files follow a very simple format based on two pairs of xyz coordinates the create a line segment. 

It also has some functionality to create components, set names of components, and to load files from 

the library with component properties. 

11.1 Description of .tpe file format 
See 0 for example of file.  

11.1.1 Elements 
The basics of a .tpe file is two sets of coordinates represented by 6 numbers. X, Y, Z of the first node and 

Z, Y, Z of the 2nd node. At the most basic level, this is all a .tpe file needs to contain. Two sets of 

coordinates always represents one line, and the number can be placed after each other with spaces in 

between. 

Example:  

0 0 0 1 1 1  

Creates one line from (0, 0, 0) to (1, 1, 1). 

Example:  

0 0 0 1 1 1 2 2 2 3 3 3  

Creates two lines. One from (0, 0, 0) to (1, 1, 1) and one from (2, 2, 2) to (3, 3, 3). 

In these cases line splitting does not matter. 

http://viewfinderpanoramas.org/dem3.html
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11.1.2 Components 
The lines can be divided into components, either using “***” which creates a new, unnamed truss 

component named “Imported data (number in the sequence)”. This command can be interleaved 

anywhere. 

Example:  

0 0 0 1 1 1 *** 2 2 2 3 3 3  

Creates two components, one implicit called “Imported data” for the first element, and “Imported data 

(1)” for the 2nd element. 

In addition to this command there is also a command to insert a named component using “###”. This 

command requires a line break after the name of the component. 

Example:  

0 0 0 -10 -10 -10 ### Test1 
1 1 1 10 10 10 

Creates two components, one called “Imported data” for the first element, and one called Test1 with a 

line from (1, 1, 1) to (10, 10, 10) in it. 

Note how this requires a line break after the component name in order to function correctly, also note 

that “(“ and “)” are reserved letters and cannot be used in the component name. 

11.1.3 Component type 
When using ### to create components one can also specify the type of the component, this is done by 

putting the type of the component in parentheses behind it, like (truss), (beam), or (membrane) 

Example: 

### Test2 (beam) 

10 10 10 50 50 50 
50 50 50 100 100 100 

This creates a component named “Test2” of type beam with two lines (10, 10, 10) to (50, 50, 50) and 

(50, 50, 50) to (100, 100, 100). 

11.1.4 Library integration 
When specifying the type of the component one can also optionally choose a template from the library 

to copy the component properties. This is done by specifying the name of the library template after the 

component type, separated by a comma. Note that component type must be supplied for AquaEdit to 

find the correct library. The name for the library template is the name set in the template component 

itself, which can be different from the filename of the template. 
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Example: 

### Test2 (truss,LibraryItem) 
10 10 10 50 50 50 
50 50 50 100 100 100 

This creates a component called “Test2” of type truss, and applies the library template called 

LibraryItem, if it can find it, from the truss library on the PC. 

11.1.5 DOF 
Translational degrees of freedom can also be specified using underscore (_) in front of the number. 

There must not be any spaces between them. The last overridden DOF will always be used. 

Rotational degrees of freedom can be specified using star (*). Note that there cannot be any spaces, and 

if both translational and rotational is specified, the translational must be specified first 

Example: 

### Test1 
_1 _1 _1 10 10 10 

1 1 1 -1 -1 -1 
5 5 5 _*15 _*15 _*15 

This creates the following lines, one from (1,1,1) to (10,10,10). The node at (1,1,1) will have all three 

translational DOFs turned on. The 2nd line from (1,1,1) to (-1,-1,-1) will have its (1,1,1) node merged with 

the previous element, and since there are no DOF overrides on this line the node will continue to have 

all three translational DOFs turned on. 

A line will also be made from (5, 5, 5) to (15, 15, 15), the last node will have all its degrees of freedom 

locked. 

11.1.6 Divide line 
Using the tilde (~) a line can be set to divided into multiple segments. 

Example: 

0 0 0 ~10 100 0 0 

This will create a line from (0, 0, 0) to (100, 0, 0) and it will be split into 10 segments. Note that the 

nodes in between the two endpoints cannot be assigned properties. 

11.1.7 Point load 
Using the percentage symbol (%) a pointload can be assigned to a node. It takes a single number 

following the % with no spaces. This value becomes the Z force (in Newton) of the pointload 

Example: 

%50 0 0 0 %10 100 0 0 

The above example will create a line from (0, 0, 0) to (100, 0, 0) and a 50 N in the Z direction pointload 

will be added to the first node, and a 10 N in the Z direction pointload on the 2nd node. 



   

143 
AquaSim 2.17 

11.1.8 Node decorator from library 
Using &&& Decorator type,Name of decorator library item on its own line will make the next node get a 

node decorator loaded from the library. 

The decorator type must be specified first (spring, impulseload, pointload, prescribeddisplacement, 

valve,shapedecroator) and then the name of library item. This must match the filename found in 

LIBRARY\decorators\type of decorator, excluding the .xml file. 

Example: 

10 10 10  

&&& Spring,Test Boye 
50 50 50 

11.1.9 Continuation 
Instead of having to specify every node twice when creating longer segments, the hash symbol (#) can 

be used to specify using the last node position instead. 

Example 

0 0 0 # 0 10 0 # 10 10 0 # 10 0 0 # 0 0 0 

This example creates a 10m by 10m square, from (0, 0, 0) to (0, 10, 0) to (10, 10, 0) to (10, 0, 0) and back 

to (0, 0, 0) 
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11.2 Example .tpe file 
0 0 0 1 1 1 
*** 

0 0 0 -10 -10 -10 

### Test1 

_1 _1 _1  

&&& Spring, Test Boye 
10 10 10 

### Test2 (truss,LibraryItem) 

10 10 10 50 50 50 

50 50 50 100 100 100 

### Test3 (beam,LibraryItem2) 

100 100 100 1000 1000 1000 
### Verification 

5 5 0 _10 _5 _0  

10 5 0 *20 *5 *0 

20 5 0 

~10 

%100 
_*100 _*5 _*0 

# 

~5 

100 100 0 

# 

~5 

5 100 0 

# 

~5 
5 5 0 

Please note: This example assumes that there is a truss library item name LibraryItem, a beam library 

item named LibraryItem2, and a spring library item called Test Boye 

11.3 Advanced settings 
import.tpe.charset The charset to use when importing files. Default 

is UTF-8. Acceptable values include (but not 
limited to): UTF-8, windows-1252 
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